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Introduction

Using either the xPC Target™ API dynamic link library (DLL) or the xPC
Target component object model (COM) API library, you can create custom
applications to control a real-time application running on the target PC. You
generate real-time applications from Simulink® models.

xPC Target™ API versus xPC Briefly describes each library and
Target™ COM API (p. 1-2) why you might want to use one
library over the other.

What Is xPC Target™ API? (p. 1-4)  Describes the xPC Target API

library.
What Is xPC Target™ COM API? Describes the xPC Target COM API
(p. 1-6) library.
Required Products (p. 1-8) Products from The MathWorks and

third-party products you need to use
with xPC Target
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xPC Target™ API versus xPC Target™ COM API

The xPC Target™ API and xPC Target COM API interfaces provide the same
functionality for you to write custom applications. There is no difference in
performance or functionality between applications written against either
library. Note that the APIs are not threadsafe.

The xPC Target API DLL consists of C functions that you can incorporate into
any high-level language application. The xPC Target COM API consists of

a suite of interfaces that you can reference while building a graphic user
interface (GUI) application. You can incorporate these interfaces using
programming environments that work with COM objects. A user can use an
application written through either interface to load, run, and monitor an xPC
Target application without interacting with MATLAB®. With the xPC Target
API, you write the application in a high-level language (such as C, C++, or
Java) that works with an xPC Target application; this option requires that
you are an experienced programmer. With xPC Target COM API, you use a
graphical development environment to create a GUI that works with an xPC
Target application. Designed to work with Microsoft® COM, the xPC Target
COM API conforms to the component object model standard established by
Microsoft.

The xPC Target API is distributed with two dynamic link libraries (DLLs)
that make it easier to integrate with various development tools, tailoring the
development environment to your needs:

¢ A function library (xpcapi.dll)

® A component library (xpcapicom.dll)
The following sections describe each library:

e “What Is xPC Target™ API?” on page 1-4
e “What Is xPC Target™ COM API?” on page 1-6



xPC Target™ API versus xPC Target™ COM API

Note In this book, second-person references apply to those who write the xPC
Target API and COM API applications. For example, “You can assign multiple
labels to one tag.” Third-person references apply to those who run the xPC
Target API and COM API applications. For example, “You can later distribute
this executable to users, who can then use the GUI application to work with
target applications.”
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What Is xPC Target™ API?

The xPC Target™ API consists of a series of C functions that you can call from
a C or C++ application. These functions enable you to

¢ Establish communication between the host PC and the target PC via an
Ethernet or serial connection

¢ Load the target application, a .d1m file, to the target PC

¢ Run that application on the target PC

® Monitor the behavior of the target application on the target PC
e Stop that application on the target PC

¢ Unload the target application from the target PC

¢ (Close the connection to the target PC

The xpcapi.dll file contains the xPC Target API dynamic link library. It
contains over 90 functions that enable run-time linking rather than static
linking at compile time. The functions provide all the information and
accessibility needed to access the target application. Accessing the xPC Target
API DLL is beneficial when you are building applications using development
environments such as Microsoft Foundation Class Library/Active Template
Library (MFC/ATL), DLL, Win32 (non-MFS) program and DLL, and console
programs integrating with third-party product APIs (for example, Altia).

All custom xPC Target API applications must link with the xpcapi.dll
file (xPC API DLL). Also associated with the dynamic link library is the
xpcinitfree.c file. This file contains functions that load and unload the
xPC Target API. You must build this file along with the custom xPC Target
API application.

The documentation reflects the fact that the API is written in the C
programming language. However, the API functions are usable from other
languages and applications, such as C++ and Java.
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Note To write a non-C application that calls functions in the xPC Target API
library, refer to the compiler documentation for a description of how to access
functions from a library DLL. You must follow these directions to access the
xPC Target API DLL.

The following chapters describe the xPC Target API in more detail:

¢ Chapter 2, “xPC Target API” describes how to create a C xPC Target API
application.

e Chapter 5, “API Function and Method Reference” and Chapter 6, “API
Functions and Methods” describe the xPC Target C and COM API functions.

1-5
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What Is xPC Target™ COM API?

The xPC Target™ COM API is an open environment application program
interface designed to work with Microsoft COM and the xPC Target API. The
xPC Target COM API provides the same functionality as the xPC Target APIL.
It is a programming layer that sits between you and the xPC Target API.
The difference is that while the xPC Target API is a dynamic link library of
C functions, the xPC Target COM API dynamic link library is an organized
collection of objects, classes, and functions. You access this collection through
a graphical development environment such as Microsoft Visual Basic. Using
such a graphical development environment, you can create a custom GUI
application that can work with one xPC Target application. While the xPC
Target API requires you to be an accomplished C or C++ programmer, the xPC
Target COM API makes no such demand.

The xPC Target COM API library depends on xpcapi.dll, the xPC Target
dynamic link library. However, the xPC Target API is independent of the
xPC Target COM API.

The xPC Target COM API has the following features:

¢ A DLL component server library — xpcapicom.dll is a component server
DLL library COM interface consisting of component interfaces that access
the target PC. The COM API library enhances the built-in functionality of
a programming language by allowing you to easily access the xPC Target
API for rapid development of xPC Target GUI.

¢ Built on top of the xPC Target API — Via an application such as Visual
Basic, xpcapicom.dll, using a structured object model hierarchy, provides
full access to all the data and methods needed to interface with an xPC
Target application. It also enables search functionality and bidirectional
browsing capabilities. Generally, you view object models by selecting a type
and viewing its members. Using the xPC Target COM API library, you can
select a member and view the types to which it belongs.

® Programming language independent — This section describes how to create
an xPC Target COM API application using Visual Basic. However, the xPC
Target COM API interface is not limited to this third-party product. You
can add the COM API library to any development environment that can
access COM libraries, such as Visual C++ or Java, as well as scripting
languages such as Perl, Python, and Basic.



What Is xPC Target™ COM API?2

¢ Ideal for use with Visual Basic — The xPC Target COM API works well
with Visual Basic, and extends the event-driven programming environment
of Visual Basic.

See Chapter 3, “xPC Target™ COM API” for a description of how to use the
xPC Target COM API library.

1-7
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Required Products

Refer to “Required Products” in the xPC Target™ Getting Started Guide for a
list of the required xPC Target products. In addition, you need the following
products:

¢ Third-Party Compiler — Use a third-party compiler to build a custom

application that calls functions from the xPC API library. Although the
xPC API library is written in C, you can write the application that calls
these functions in another high-level language, such as C++. You can use
any compiler that can generate code for Win32 systems.

To write a non-C application that calls functions in the xPC Target API
library, refer to the compiler documentation for a description of how to
access functions from a library DLL. You must follow these directions to
access the xPC Target API DLL.

Third-Party Graphical Development Environment — Use a third-party
graphical development environment to build a custom application that
references interfaces in the xPC COM API library. Layered on top of the
xPC API library, the xPC COM API library enables you to write custom
applications using a component object model library. You can use any
compiler that can work with component object model (COM) objects.
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Before You Start (p. 2-2)
Visual C Example (p. 2-5)

Introduces the xPC Target API.

Describes how to use Microsoft
Visual C++ to generate a Visual C
application that can download and
run an xPC Target application.
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Before You Start

In this section...

“Introduction” on page 2-2

“Important Guidelines” on page 2-2

Introduction

This chapter describes how to write a custom application using the xPC
Target API. This API enables you to write high-level language applications to
load an xPC Target application, and run and control it.

Before you start, read this section for important notes on writing custom
applications based on the xPC Target API. It is assumed that you already
know how to write C or C++ code.

This chapter provides tutorials on how to generate a C application for xPC
Target. It also provides some guidelines on using the xPC Target API. Refer
to “Visual C Example” on page 2-5 for tutorials that you can follow to create,
build, and run a sample Visual C program.

For the xPC Target API function synopses and descriptions, refer to “API
Function and Method Reference”.

Important Guidelines

This section describes some guidelines you should keep in mind before
beginning to write xPC Target API applications with the xPC Target API DLL:

® You must carefully match the data types of the functions documented in
the API function reference. For C, the API includes a header file that
matches the data types.

¢ To write a non-C application that calls functions in the xPC Target API
library, refer to the compiler documentation for a description of how to
access functions from a library DLL. You must follow these directions to
access the xPC Target API DLL
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¢ If you want to rebuild the model sf_car_xpc.mdl, or otherwise use
MATLAB, you must have xPC Target Version 2.0 or later. This is the
version of XPC Target that comes with Release 13 (MATLAB 6.5) or later.

To determine the version of xPC Target you are currently using, at the
MATLAB command line, type

xpclib

This opens the xPC Target Simulink blocks library. The version of xPC
Target should be at the bottom of the window.

® You can work with xPC Target applications with either MATLAB or an xPC
Target API application. If you are working with an xPC Target application
simultaneously with a MATLAB session interacting with the target, keep
in mind that only one application can access the target PC at a time. To
move from the MATLAB session to your application, in the MATLAB
Command Window, type

close(xpc)

This frees the connection to the target PC for use by your xPC Target API
application. Conversely, you will need to quit your application, or do the
equivalent of calling the function xPCClosePort, to access the target from
a MATLAB session.

e All xPC Target API functions that communicate with the target PC check
for time-outs during communication. If a time-out occurs, these functions
will exit with the global variable xPCError set to either ECOMTIMEOUT
(serial connections) or ETCPTIMEOUT (TCP/IP connections). Use the
xPCGetLoadTimeOut and xPCSetLoadTimeOut functions to get and set the
time-out values, respectively.

There are a few things that are not covered in Chapter 5, “API Function and
Method Reference” and Chapter 6, “API Functions and Methods” for the
individual functions, because they are common to almost all the functions in
the xPC Target API. These are

® Almost every function (except xPCOpenSerialPort, xPCOpenTcpIpPort,
xPCGetLastError, and xPCErrorMsg) has as one of its parameters the
integer variable port. This variable is returned by xPCOpenSerialPort
and xPCOpenTcpIpPort, and is the placeholder for the communications link
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with the target PC. The returned value from these two functions should
be used in the other functions to ensure that the proper communications
channel is used.

Almost every function (except xPCGetLastError and xPCErrorMsg) sets a
global error value in case of error. The application obtains this value by
calling the function xPCGetLastError, and retrieves a descriptive string
about the error by using the function xPCErrorMsg. Although the actual
values of the error numbers are subject to change, a zero value always
means that the operation completed without errors, while a nonzero value
typically signifies an error condition. Note also that the library resets the
error value every time an API function is called; therefore, your application
should check the error status as soon as possible after a function call.

Some functions also use their return values (if applicable) to signify that
an error has occurred. In these cases as well, you can obtain the exact
error with xPCGetLastError.
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Visual C Example

In this section...

“Introduction” on page 2-5

“Directories and Files” on page 2-5

“Building the xPC Target Application” on page 2-7

“Creating a Visual C Application” on page 2-7

“Building a Visual C Application” on page 2-12

“Running a Visual C xPC Target API Application” on page 2-12
“Using the xPC Target API C Application” on page 2-13

“C Code for sf_car_xpc.c” on page 2-19

Introduction

This release includes an example using the xPC Target API to create a Win32
console application written in C. You can use this example as a template to
write your own application.

Before you start, you should have an existing xPC Target application that you
want to load and run on a target PC. The following tutorials use the target
application sf_car_xpc.dlm, built from the Simulink model sf_car_xpc.mdl,
which models an automatic transmission control system. The automatic
transmission control system consists of modules that represent the engine,
transmission, and vehicle, with an additional logic block to control the
transmission ratio. User inputs to the model are in the form of throttle (%)
and brake torque (pound-foot). You can control the target application through
MATLAB with the Simulink External Model interface, or through a custom
xPC Target API application, which you can create using the tutorials in this
chapter.

Directories and Files

This directory contains the C source of a Win32 console application that serves
as an example for using the xPC Target API. The necessary sf_car_xpc files
are in the directory
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C:\matlabroot\toolbox\rtw\targets\xpc\api

Filename Description

VisualBasic\Models\ - Simulink model for use with xPC Target
sf_car_xpc\sf_car_xpc.mdl

VisualBasic\Models\ - Target application compiled from Simulink
sf_car_xpc\sf_car_xpc.dlm | model

VisualC\sf_car_xpc.dsp Project file for API application
sf_car_xpc.c Source code for API application
VisualC\sf_car_xpc.exe Compiled API application
VisualBasic\Models)\ - xPC Target API functions for all
xpcapi.dll programming languages. Place this file in

one of the following, in order of preference:

¢ Directory from which the application is
loaded

¢ Windows system directory

The necessary xPC Target API files are in the directory

C:\matlabroot\toolbox\rtw\targets\xpc\api

You will need the files listed below for creating your own API application
with Microsoft Visual C++.

Filename Description

xpcapi.h Mapping of data types between xPC Target API and
Visual C

xpcapiconst.h Symbolic constants for using scope, communication,
and data-logging functions

xpcinitfree.c C functions to upload API from xpcapi.dll

xpcapi.dll xPC Target API functions for all programming
languages




Visual C Example

Building the xPC Target Application
The tutorials in this chapter use the prebuilt xPC Target application

C:\matlabroot\toolbox\rtw\targets\
xpc\api\VisualC\sf_car_xpc.dlm

You can rebuild this application for your example:

1 Create a new directory under your MathWorks directory. For example,
D:\mwd\sf_car_xpc2

2 Create a Simulink model and save to this directory. For example,
sf_car_xpc2.mdl

3 Build the target application with Real-Time Workshop® and Microsoft
Visual C++. The target application file sf_car_xpc2.d1lm is created.

Using Another C/C++ Compiler

The tutorials in this chapter describe how to create and build C applications
using Microsoft Visual C++. However, to build an xPC Target API C
application, you can use any C/C++ compiler capable of generating a
Win32 application. You will need to link and compile the xPC Target API
application along with xpcinitfree.c to generate the executable. The file
xpcinitfree.c contains the definitions for the files in the xPC Target API
and is located at

C:\matlabroot\toolbox\rtw\targets\xpc\api

Creating a Visual C Application

This tutorial describes how to create a Visual C application. It is assumed
that you know how to write C applications. Of particular note when writing
xPC Target API applications,

e (Call the function xPCInitAPI at the start of the application to load the
functions.

e (Call the function xPCFreeAPI at the end of the application to free the
memory allocated to the functions.
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To create a C application with a program such as Microsoft Visual C++,

1 From the previous tutorial, change directory to the new directory. This is
your working directory. For example,

D:\mwd\sf_car_xpc2

2 Copy the files xpcapi.h, xpcapi.dll, xpcapiconst.h, and xpcintfree.c
to the working directory. For example,

D:\mwd\sf_car_xpc2

3 Click the Start button, choose the Programs option, and choose the
Microsoft Visual C++ entry. Select the Microsoft Visual C++ option.

The Microsoft Visual C++ application is displayed.
4 From the File menu, click New.

5 At the New dialog, click the File tab.
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2%
Files | Frojects | Workspaces Other Documents
] Active Server Page ™ Add to project:
22 Binary File J
(=[] -
4| Bitap File I
L+ Header File

: C++ Source File File name:;
E% Curzar File Isf_cal_:-:pc.c
[$] HTML Page
m lcon File Location:
I<: M acro File ID:\mwd\&f_u:ar_:-:pﬂ J

Resource Script
Rezource Template
SEL Script File
Text File

0K I Cancel |

6 In the left pane, select C++ Source File. In the right, enter the name of
the file. For example, sf_car_xpc.c. Select the directory. For example,
C:\mwd\sf_car_xpc2.

7 Click OK to create this file.

8 Enter your code in this file. For example, you can enter the contents of
sf_xpc_car.c into this file.

9 From the File menu, click New.

10 At the New dialog, click the Projects tab.

2-9
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Filez F'miects[% Workspaces I Other Documents I

e ATL COM Appiwizard Project name:

¢ | Cluster Resource Type “Wizard I&f_u:ar_:-:pu:

g<| Custom Appiafizard .
‘=1 D atabase Project Logation:

2 [ev'S tudio Add-in Wizard |D:\mwd\SF_D&H_XPEE\sf_car J
& |SAP! Extenszion Wizard
M ak efile
il FC ActiveX Controbafizard O Oz iemraksssse
[8] MFC Appiwizard [d)

) Add b current workspace
A hiFC Appwizard [exe]

T4 Utility Praject I j
A |'Win3Z Application

: neale Application:
| %] Wiir32 Dynamic-Link Library

% \win32 Static Library SST”;Z
I (g}

[~ Dependency of:

0K I Cancel |

11 In the left pane, select Win32 Console Application. On the right, enter
the name of the project. For example, sf_car_xpc. Select the working
directory from step 1. For example, C:\mwd\sf_car_xpc2.

12 To create the project, click OK.
A Win32 Console Application dialog is displayed.
13 To create an empty project, select An empty project.
14 Click Finish.
15 To confirm the creation of an empty project, click OK at the following dialog.

16 To add the C file you created in step 7, from the Project menu, select the
Add to Project option and select Files.

17 Browse for the C file you created in step 7. For example,
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D:\mwd\sf_car_xpc2\sf_car_xpc.c
Click OK.

18 Browse for the xpcinitfree.c file. For example, D: \mwd\xpcinitfree.c.
Click OK.

Note The code for linking in the functions in xpcapi.dll is in the file
xpcinitfree.c. You must compile and link xpcinitfree.c along with
your custom application for xpcapi.dll to be properly loaded.

19 If you did not copy the files xpcapi.h, xpcapi.dll, and xpcapiconst.h
into the working or project directory, you should either copy them now, or
also add these files to the project.

20 From the File menu, click Save Workspace.

When you are ready to build your C application, go to “Building a Visual
C Application” on page 2-12.

Placing the Target Application File in a Different Directory

The sf_car_xpc.c file assumes that the xPC Target application file
sf_car_xpc.dlmis in the same directory as sf_car_xpc.c. If you move that
target application file (sf_car_xpc.d1lm) to a new location, change the path
to this file in the API application (sf_car_xpc.c) and recompile the API
application. The relevant line in sf_car_xpc.c is in the function main(),
and looks like this:

xPCLoadApp(port, ".", "sf_car_xpc"); checkError("LoadApp: ");

The second argument (".") in the call to xPCLoadApp is the path to
sf_car_xpc.dlm. The "." indicates that the files sf_car_xpc.dlm and
sf_car_xpc.c are in the same directory. If you move the target application,
enter its new path and rebuild the xPC Target API application.

2-11
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2-12

Building a Visual C Application

This tutorial describes how to build the Visual C application from the previous
tutorial, or to rebuild the example executable sf_car_xpc.exe, with Microsoft
Visual C++:

1 To build your own application using the xPC Target API, ensure that the
files xpcapi.h, xpcapi.dll, xpcapiconst.h, and xpcinitfree.c are in
the working or project directory.

2 If Microsoft Visual C++ is not already running, click the Start button,
choose the Programs option, and choose the Microsoft Visual C++ entry.
Select the Microsoft Visual C++ option.

3 From the File menu, click Open.
The Open dialog is displayed.

4 Use the browser to select the project file for the application you want to
build. For example, sf_car_xpc.dsp.

5 If a corresponding workspace file (for example, sf_car_xpc.dsw) exists for
that project, a dialog prompts you to open that workspace instead. Click
OK.

6 Build the application for the project. From the Build menu, select either
the Build project _name.exe or Rebuild All option.

Microsoft Visual C++ creates a file named project_name.exe, where
project _name is the name of the project.

When you are ready to run your Visual C Application, go to “Running a Visual
C xPC Target API Application” on page 2-12.

Running a Visual C xPC Target APl Application

Before starting the API application sf_car_xpc.exe, ensure the following:

¢ The file xpcapi.d1ll must either be in the same directory as the xPC Target
API application executable, or it must be in the Windows system directory
(typically C:\windows\system or C:\winnt\system32) for global access.
The xPC Target API application depends on this file, and will not run if the
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file is not found. The same is true for other applications you write using
xPC Target API functions.

® The compiled target application sf_car_xpc.dlm must be in the same
directory as the xPC Target API executable. Do not move this file out of
this directory. Moving the file requires you to change the path to the target
application in the API application and recompile, as described in “Building
a Visual C Application” on page 2-12.

Using the xPC Target API C Application

Any xPC Target API application requires you to have a working target PC
running at least xPC Target Version 2.0 (Release 13).

This tutorial assumes that you are using the xPC Target API application
sf_car_xpc.exe that comes with xPC Target. In turn, sf_car_xpc.exe
expects that the xPC Target application is sf_car_xpc.dlm.

If you are going to run a version of sf_car_xpc.exe that you compiled yourself
using the sf_car_xpc.c code that comes with xPC Target, you can run that
application instead. Ensure that the following files are in the same directory:
e sf car_xpc.exe, the xPC Target API executable

e sf _car_xpc.dlm, the xPC Target application to be loaded to the target PC
e xpcapi.dll, the xPC Target API dynamic link library

If you copy this file to the Windows system directory, you do not need to
provide this file in the same directory.

How to Run the sf car_xpc Executable

1 Create an xPC Target boot disk with a serial or network communication. If
you use serial communications, set the baud rate to 115200. Otherwise,
create the boot disk as directed in xPC Target Getting Started.

2 Start the target PC with the xPC Target boot disk.

The target PC displays messages like the following in the top rightmost
message area.
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System: Host-Target Interface is RS232 (COM1/2)
or
System: Host-Target Interface is TCP/IP (Ethernet)

If you have downloaded target applications to the target PC through
MATLAB, in the MATLAB window, type

close(xpc)

This command disconnects MATLAB from the target PC and leaves the
target PC ready to connect to another client.

On the host PC, open a DOS window. Change directory to

C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualC

If you are running your own version of sf_car_xpc.exe, change to the
directory that contains the executable and xPC Target application. For
example,

D:\mwd\sf_car_xpc2

From that DOS window, enter the command to start the demo application
on the host PC and download the target application to the target PC.

The syntax for the demo command is
sf_car_xpc {-t IpAddress:IpPort|-c COMport}

If you set up the xPC Target boot disk to use TCP/IP, then give the target
PC’s IP address and IP port as arguments to sf_car_xpc, along with the
option -t. For example, at the DOS prompt, type

sf_car_xpc -t 192.168.0.1:22222

If you set up the xPC Target boot disk to use RS-232, give the serial port
number as a command-line option. Note that indexing of serial ports starts
from 0 instead of 1. For example, if you are using serial communication
from COM port 1 on the host PC, type

sf_car_xpc -c O
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On the host PC, the demo application displays the following message:

K o o o o o o e e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e o *
* xPC Target API Demo: sf_car_xpc. *
* *
* Copyright (c) 2000 The MathWorks, Inc. All Rights Reserved. *
* *

Application sf_car_xpc loaded. SampleTime 0.001 StopTime: -1
R Br Th G VehSpeed VehRPM

N 0 00 0.000 1000.000

The relevant line here is the last one, which displays the status of the
application. The headings are as follows:

R The status of the target application: R if running, N if
stopped

Br The brake torque; legal values range from 0 to 4000

Th The throttle as a percentage (0 - 100) of the total

G Gear the vehicle is in (ranges between 1 and 4)

VehSpeed  Speed of the vehicle in miles per hour
VehRPM Revolutions per minute of the vehicle engine (0 to 6000)
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From this screen, various keystrokes control the target application. The
following list summarizes these keys:

Key Action

s Start or stop the application, as appropriate.

T Increase the throttle by 1 (does not go above 100).

t Decrease the throttle by 1 (does not go below 0).

B Increase the brake value by 20 (does not go above
4000). Note that a positive value for the brake
automatically sets the throttle value to 0, and a
positive value for the throttle automatically sets the
brake value to 0.

b Decrease the brake value by 20 (does not go below 0).

Q or Ctrl+C Quit the application.
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The target PC displays the following messages and three scopes.

+} Real-Time xPC Target Spy

=f_car_xpo B lower y—axis limit set to @.008000

SEMB H uppey y-axis limit set to O. 000060

signal & added

tet Humfamples set to 36

Inf 4 trigger level set to ©B.000000
TriggerScope set to 1

8. 881 H lowey y—axis limit set to @.3080080

- upper y-axis limit set to 180.0000008

stopped d : initializing application finished

RT, single

6 Hold down the Shift key and hold down T until the value of Th reaches 100.

2-17



2 xPC Target API

7 Press s to start the application.

»} Real-Time xPC Target Spy I

=f_car_mpc H Farameter updated
123MBE I parameter updated
rarameter updated
parameter updated
Inf 4 parameter updated A
i execution started (sample time: @.081008)

8. 601 i execution stopped atr 31.68350808
2.944e-005 minimal TET: @.BB0026 at time 1.406000

maximal TET: @.000040 at time B8.4010008

RT. single
tet

7
4. 0800608

The first scope (SC1) shows the throttle rising to a maximum value of 100
and the vehicle speed gradually increasing. The third scope (SC3) shows
the vehicle RPM. Notice the changes in the vehicle RPM as the gears shift
from first to fourth gear as displayed in the third numerical scope (SC2).

8 When you are done testing the demo application, type Q or Ctrl+C.

The demo application is disconnected from the target PC, so you can
reconnect to MATLAB.
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C Code for sf_car_xpc.c
This section contains the C code for the sf_car_xpc.c application:

/* File: sf_car_xpc.c

* Abstract: Demonstrates the use of the xPC Target C-API in Human-Machine

* interaction. This file generates a Win32 Console application,

* which when invoked loads the sf_car_xpc.dlm compiled application
* on to the xPC Target PC.

*

* To build the executable, use the Visual C/C++ project

* sf_car_xpc.dsp.

*
* Copyright 2000-2004 The MathWorks, Inc.
*/

/* Standard include files */
#include <stdio.h>

#include <stdlib.h>

#include <limits.h>

#include <ctype.h>

#include <conio.h>

#include <windows.h>

/* xPC Target C-API specific includes */
#include "xpcapi.h"
#include "xpcapiconst.h"

#define SERIAL O
#define TCPIP 1

/* max and min are defined by some compilers, so we wrap them in #ifndef's */
#ifndef max

#define max(a, b) (((a) > (b)) ? (a) : (b))

#endif

#ifndef min

#define min(a, b) (((a) < (b)) ? (a) : (b))

#endif

/* Global Variables */
int mode = TCPIP, comPort = 0;
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int
int
char

/* F
doub
void
void
void

void
void
void
void
void
int

/* F

port;
thrPID, brakePID, rpmSID, speedSID, gearSID;
*ipAddress, *ipPort, *pathToApp = NULL;

unction prototypes */

le getParam(int parlIdx);
setParam(int parlIdx, double parValue);
findParam(char *block, char *param, int *id);
findSignal(char *sig, int *id);

Usage(void);

cleanUp(void);

checkError(char *str);
processKeys(void);

parseArgs(int argc, char *argv[]);
str2Int(char *str);

unction: main =====

* Abstract: Main function for the sf_car_xpc demo

int

main(int argc, char *argv[]) {
printf("\n"

"x xPC Target API Demo: sf_car_xpc.

"* Copyright (c) 2000 The MathWorks, Inc. All Rights Reserved.

SUBE

parseArgs(argc, argv);

atexit(cleanup);

/* Initialize the API */

if (XPCINitAPI()) {
fprintf(stderr, "Could not load api\n");
return -1;

if (mode == SERIAL)
port = xPCOpenSerialPort(comPort, 0);
else if (mode == TCPIP)

*/
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port = xPCOpenTcpIpPort(ipAddress, ipPort);

else {
fprintf(stderr, "Invalid communication mode\n");
exit (EXIT_FAILURE);

}

checkError("PortOpen: ");

xPCLoadApp(port, ".", "sf_car_xpc"); checkError("LoadApp: ")

printf("Application sf_car_xpc loaded, SampleTime: %g StopTime: %g\n\n",
xPCGetSampleTime(port), xPCGetStopTime(port));

checkError (NULL) ;

findParam("Throttle", "Value", &thrPID);
findParam("Brake", "Value", &brakePID);
findSignal("Engine/rpm", &rpmSID);
findSignal("Vehicle/mph", &speedSID);
findSignal("shift_logic/p1", &gearSID);

processKeys(); /* Heart of the application */

if (xPCIsAppRunning(port)) {
xPCStopApp(port);
}

return 0;

} /* end main() */

/* Function: processKeys

* Abstract: This function reads and processes the keystrokes typed by the

*

*

user and takes action based on them. This function runs for most
of the program life. */

void processKeys(void) {

int c = 0;
double throttle, brake;

throttle = getParam(thrPID);

brake = getParam(brakePID);

fputs("\nR Br Th G VehSpeed VehRPM \n", stdout);
fputs( "- “--- N L LT L L \n", stdout);
while (1) {

if (_kbhit()) {
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c = _getch();
switch (c) {
case 't':
if (throttle)
setParam(thrPID, --throttle);
break;
case 'T':
if (brake)
setParam(brakePID, (brake = 0));
if (throttle < 100)
setParam(thrPID, ++throttle);
break;
case 'b':
setParam(brakePID, (brake = max(brake - 200, 0)));
if (brake)
setParam(thrPID, (throttle
break;

0));

case 'B':
if (throttle)
setParam(thrPID, (throttle = 0));
setParam(brakePID, (brake = min(brake + 200, 4000)));
break;
case 's':
case 'S':
if (xPCIsAppRunning(port)) {
xPCStopApp(port); checkError(NULL);
} else {
xPCStartApp(port); checkError(NULL);
}
break;
case 'q':
case 'Q':
return;
break;
default:
fputc(7, stderr);
break;
}
} else {
Sleep(50);
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}

printf( "\r%c %4d %3d %1d %10.3f %10.3F",
(XPCIsAppRunning(port) ? 'Y' ‘N'),
(int)brake, (int)throttle,

(int)xPCGetSignal(port, gearSID),
xPCGetSignal(port, speedSID),
xPCGetSignal(port, rpmSID));

}

} /* end processKeys() */

/* Function:

Usage ====
* Abstract: Prints a simple usage message.

void Usage(void) {

*/

fprintf(stdout,
"Usage: sf_car_xpc {-t IPAddress:IpPort|-c num}\n\n"
"E.g.: sf_car_xpc -t 192.168.0.1:22222\n"
"E.g.: sf_car_xpc -c 1\n\n");

return;
} /* end Usage() */

str2int

/* Function:

"123string" is
*/

* Abstract: Converts the supplied string str to an integer. Returns INT_MIN
* if the string is invalid as an integer (e.g.
* invalid) or if the string is empty.
int str2Int(char *str) {
char *tmp;
int tmpInt;
tmpInt = (int)strtol(str, &tmp, 10);
if (*str == '\0' || (*tmp != '"\0')) {

return INT_MIN;
}
return tmpInt;
} /* end str2Int */

/* Function:
* Abstract:
* based on the arguments.

parseArgs

void parseArgs(int argc, char *argv[]) {
if (argc != 3) {
fprintf(stderr,

Parses the command line arguments and sets the state of variables

*/

"Insufficient command line arguments.\n\n");
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Usage();
exit (EXIT_FAILURE);
}
if (strlen(argv[1]) != 2 |
strchr("-/", argv[1][0]) == NULL ||
strchr("tTcC", argv[1][1]) == NULL) {
fprintf(stderr, "Unrecognized Argument %s\n\n", argv[1]);

(
(

Usage();
exit (EXIT_FAILURE);
}
mode = tolower(argv[1][1]) == 'c' ? SERIAL : TCPIP;
if (mode == SERIAL) {
int tmplInt;
if ((tmpInt = str2Int(argv[2])) > INT_MIN) {
comPort = tmpInt;
} else {
fprintf(stderr, "Unrecognized argument %s\n", argv[2]);
Usage();
}
} else {
char *tmp;
ipAddress = argv[2];
if ((tmp = strchr(argv[2], ':')) == NULL) {
/* memory need not be freed as it is allocated only once, will *
* hang around till app ends. */
if ((ipPort = malloc(6 * sizeof(char))) == NULL) {
fprintf(stderr, "Unable to allocate memory");
exit (EXIT_FAILURE);
}
strcpy(ipPort, "22222");
} else {
*tmp = '\0";
ipPort = ++tmp;

}

return;
} /* end parseArgs() */

/* Function: cleanUp ==
* Abstract: Called at program termination to exit in a clean way. */
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void cleanUp(void) {
xPCClosePort(port);
XPCFreeAPI();
return;

} /* end cleanUp() */

/* Function: checkError

* Abstract: Checks for error by calling xPCGetLastError(); if an error is
* found, prints the appropriate error message and exits. */
void checkError(char *str) {
char errMsg[80];
if (xPCGetLastError()) {
if (str != NULL)
fputs(str, stderr);
XPCErrorMsg (xPCGetLastError(), errMsg);
fputs(errMsg, stderr);
exit (EXIT_FAILURE);
}
return;
} /* end checkError() */

/* Function: findParam

* Abstract: Wrapper function around the xPCGetParamIdx() API call. Also
* checks to see if the parameter is not found, and exits in that
* case. */
void findParam(char *block, char *param, int *id) {
int tmp;
tmp = xPCGetParamIdx(port, block, param);
if (xPCGetLastError() || tmp == -1) {
fprintf(stderr, "Param %s/%s not found\n", block, param);
exit (EXIT_FAILURE);
}
*id = tmp;
return;
} /* end findParam() */

/* Function: findSignal
* Abstract: Wrapper function around the xPCGetSignalIdx() API call. Also
* checks to see if the signal is not found, and exits in that

* case. 1
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void findSignal(char *sig, int *id) {
int tmp;
tmp = xPCGetSignalIdx(port, sig);
if (xPCGetLastError() || tmp == -1) {
fprintf(stderr, "Signal %s not found\n", sig);
exit (EXIT_FAILURE);
}
*id = tmp;
return;
} /* end findSignal() */

/* Function: getParam =

* Abstract: Wrapper function around the xPCGetParam() API call. Also checks
* for error, and exits if an error is found.

double getParam(int parIdx) {
double p;
xPCGetParam(port, parIdx, &p);
checkError("GetParam: ");
return p;

} /* end getParam() */

*/

/* Function: setParam =

* Abstract: Wrapper function around the xPCSetParam() API call. Also checks
* for error, and exits if an error is found.

void setParam(int parIdx, double parValue) {
xPCSetParam(port, parIdx, &parValue);
checkError("SetParam: ");
return;

} /* end setParam() */

/** EOF sf_car_xpc.c **/

*/
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Before You Start

3-2

This chapter describes how to write a custom application using the xPC
Target™ COM API. This COM API enables you to write COM applications to
load, run, and control an xPC Target application.

Before you start, read this section for guidelines on writing custom
applications based on the xPC Target COM API. You do not need to be a
seasoned C or C++ programmer to follow the procedures in this chapter, or
to write custom applications with the xPC Target COM API. You should,
however, have some rudimentary programming knowledge.

This chapter provides procedures on how to create xPC Target COM API
applications using Microsoft® Visual Basic®:

® The procedures in this example use the model xpctank.mdl. If you want
to rebuild this model, or otherwise use the MATLAB® software, you must
have xPC Target software version 2.0 or higher.

To determine which version of the software you are currently using, at
the MATLAB command line, type

xpclib

This opens the xPC Target Simulink® blocks library. The xPC Target
software version of should be at the bottom of the window.

® You can work with xPC Target applications with either the MATLAB
software or an xPC Target COM API application. If you are working with
an xPC Target application using an xPC Target COM API application
simultaneously with a MATLAB session interacting with the target, keep
in mind that only one application can access the target PC at a time. To
move from the MATLAB session to your application, in the MATLAB
Command Window, type

close(xpc)

This frees the connection to the target PC for use by your xPC Target
COM API application. Conversely, you will need to have your COM API
application call the Close method to enable access to the target from a
MATLAB session.
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¢ Although you are building an xPC Target COM API application, you still
need to access the xpcapi.dll. When distributing the xPC Target COM
API application, place this file in one of the following, in order of preference:

= Directory from which application is loaded

= Windows® system directory
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Example Visual Basic® GUI Using COM Objects

In this section...

“Introduction” on page 3-5

“Description of Simulink® Water Tank Model” on page 3-5
“Creating a Simulink® Target Model” on page 3-7
“Tagging Block Parameters” on page 3-8

“Tagging Block Signals” on page 3-11

“Creating the Target Application and Model-Specific COM Library” on page
3-14

“Model-Specific COM Interface Library (model_nameCOMiface.dll)” on
page 3-18

“Creating a New Microsoft® Visual Basic® Project” on page 3-21

“Referencing the xPC Target™ COM API and Model-Specific COM
Libraries” on page 3-22

“Creating the Graphical Interface” on page 3-27

“Setting Properties” on page 3-29

“Writing Code” on page 3-31

“Creating the General Declarations” on page 3-33

“Creating the Load Procedure” on page 3-33

“Creating Event Procedures” on page 3-35

“Referencing Parameters and Signals Without Using Tags” on page 3-41
“Testing the Visual Basic® Application” on page 3-45

“Building the Visual Basic® Application” on page 3-45

“Deploying the API Application” on page 3-46

“Creating a New Visual Basic® Project Using Microsoft® Visual Studio® 7.1
or 8.0” on page 3-47
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Zxpctank *
File Edit ‘iew Simulakion  Formak Tools  Help

Introduction

For demonstration purposes this chapter uses the Simulink® model
xpctank.mdl and requests that you enter tags for signals and parameters

to create the Simulink model xpc_tank1.mdl. You will then build the
real-time target application xpc_tank1.d1lm and the GUI xpc_tank1_COM.exe
application using the xPC Target™ COM API library and Microsoft® Visual
Basic®.

Note These topics assume that you know how to create projects and forms
in Microsoft Visual Basic, and that you are familiar with the concept of
automatic code completion. For further details on Microsoft Visual Basic,
refer to your Microsoft® product documentation.

Description of Simulink® Water Tank Model

The xPC Target software includes the Simulink model xpctank.mdl. This is a
model of a water tank with a pump, drain, and valve controller.
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TankLevel — The water level in the tank is modeled using a limited
integrator named TankLevel.

PumpSwitch — The pump can be turned off manually to override the action
of the controller. This is done by setting PumpSwitch to 0. When PumpSwitch
is 1, the controller can use the control valve to pump water into the tank.

ValveSwitch (drain valve) — The tank has a drain valve that allows water
to flow out of the tank. Think of this as water usage or consumption that
reduces the water level. This behavior is modeled with the constant block
named ValveSwitch, the gain block Gain2, and a summing junction. The
minus sign on the summing junction has the effect of producing a negative
flow rate (drain), which reduces the water level in the tank.

When ValveSwitch is 0 (closed), the valve is closed and water cannot flow out
of the tank. When ValveSwitch is 1 (open), the valve is open and the water
level is reduced by draining the tank.

Controller — The controller is very simple. It is a bang-bang controller and
can only maintain the selected water level by turning the control valve (pump
valve) on or off. A water level set point defines the desired median water level.
Hysteresis enables the pump to avoid high-frequency on and off cycling. This
is done using symmetric upper and lower bounds that are offsets from the
median set point. As a result, the controller turns the control valve (pump
valve) on whenever the water level is below the set point minus the offset.
The summing junction compares this lower bound against the tank water
level to determine whether or not to open the control valve. If the pump is
turned on (PumpSwitch is 1) water is pumped into the tank. When the water
level reaches or exceeds the set point plus the upper bound, the controller
turns off the control valve. When the water level reaches this boundary, water
stops pumping into the tank.

Scope blocks — A standard Simulink Scope block is added to the model for
you to view signals during a simulation. xPC Target Scope blocks are added
to the model for you to view signals while running the target application.
Scope id:1displays the actual water level and the selected water level in the
tank. Scope id:2 displays the control signals. Both scopes are displayed on the
target PC using a scope of type target.



Example Visual Basic® GUI Using COM Obijects

The xpctank.mdl model is built entirely from standard Simulink blocks and
scope blocks from the xPC Target software. It does not differ in any way from
a model you would normally use with the software.

Creating a Simulink® Target Model

A target application model is a Simulink model that describes your physical
system and its behavior. You use this model to create a real-time target
application, and you use this model to select the parameters and signals you
want to connect to a custom graphical interface.

You do not have to modify this model when you use it with Virtual Reality
Toolbox™ or other third-party graphical elements.

Create a target application model before you tag block parameters and block
signals to create a custom graphical interface:

1 In the MATLAB® Command Window, type

xpctank

A Simulink model for a water tank opens. This model contains a set of
equations that describe the behavior of a water tank and a simple controller.

The controller regulates the water level in the tank. This model contains
only standard Simulink blocks and you use it to create the xPC Target
application.

2 From the File menu, click Save as and enter a new filename. For example,
enter xpc_tank1 and then click OK.

Note If you save your own copy of xpctank, be sure to be in the directory that
contains that model before calling it from the MATLAB window.

Your next task is to mark the block properties and block signals. See
“Tagging Block Parameters” on page 3-8 and “Tagging Block Signals” on page
3-11. Building an xPC Target application that has been tagged generates a
model-specific COM library, model nameifaceCOM.d1l, which you can later
reference when writing your xPC Target COM API application.
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Tagging Block Parameters

Tagging parameters in your Simulink model enables you to generate a
model-specific COM library to provide access to model parameter IDs via the
xPC Target COM API library. These interface blocks contain the parameters
you connect to control devices (such as sliders) in your model. Tagging
parameters makes it easier for you to refer to these parameters later, when
you write your xPC Target COM API application.

Note If you do not tag parameters before you generate your Simulink model,
you must specify model parameters manually. See “Referencing Parameters
and Signals Without Using Tags” on page 3-41 for this procedure.

This procedure uses the modelxpc_tanki1.mdl (or xpctank.mdl) as an
example. See “Creating a Simulink® Target Model” on page 3-7.

Note The xpctank model contains tags from the example for creating custom
user interfaces in the xPC Target User’s Guide . As you follow the procedures
in this section and the section “Tagging Block Signals” on page 3-11, you
should remove any existing tags before adding the new tags.

1 Open a Simulink model. For example, in the MATLAB window type
xpc_tank1 or xpctank.

2 Point to a Simulink block, and then right-click. For example, right-click the
SetPoint block.

3 From the menu, click Block Properties.

Cuk

Copy
Delete

Constant Parameters. ..

Block Properties. ..

A block properties dialog box opens.
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4 In the Description box, delete the existing tag and enter a tag to the
parameters for this block.

For example, the SetPoint block is a constant with a single parameter that
selects the level of water in the tank. Enter the tag shown below.

Description:

PCTag(1 1=water_lewvel, | -]

The tag has the following format:

xPCTag(1, . . . index_n)= label 1 . . . label _n;

¢ index_n — Index of a block parameter. Begin numbering parameters
with an index of 1.

® label n— Name for a block parameter to connect to a property for
the parameter you tag in the model. Separate the labels with a space,
not a comma.

label 1...label_n must consist of the same identifiers as those used by
C/C++ to name functions, variables, and so forth. Do not use names like
-foo.

You can assign multiple labels to one tag, such as

xPCTag(1)=1label;xPCTag(1)=1label2;

You might want to assign multiple labels if you want to tag a parameter
for different purposes. For example, you can tag a parameter to create
a model-specific COM library. You might also want to tag a parameter
to enable the function xpcsliface to generate a user interface template
model.

You can also issue one tag definition per line, such as

XxPCTag(1)=1label;
xPCTag(2)=1label2;
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5 Repeat step 4 for the remaining parameters you want to tag.

For example, for the Controller block, enter the tag

De=scription:

PCTagl1,2,3=upper _water_level lower _water_lewel pump_flu:uwrate;| ;I

[

For the PumpSwitch and ValveSwitch blocks, enter the tags

Description:
PCTag(1 i=pump_switch; ;I
-
Description:
PCTagl 1 1=drain_wvalve; ;I

To tag a block with four properties, use the following syntax:

xPCTag(1,2,3,4)=1label 1 label 2 label 3 label 4;

To tag a block with at least four properties for the second and fourth
properties, use the following syntax:

xPCTag(2,4)=1label_1 label 2;
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6 From the File menu, click Save as. Enter a filename for your model. For
example, enter

xpc_tank1

You next task is to tag block signals, if you have not already done so; then,
create the model. See “Tagging Block Signals” on page 3-11.

Tagging Block Signals

Tagging signals in your Simulink model enables you to generate a
model-specific COM library to provide access to model signal IDs via the
COM API library. These interface blocks contain the signals you connect

to display devices (such as labels) in your model. Tagging signals makes it
easier for you to refer to these signals later, when you write your xPC Target
COM API application. After you tag signals, you will be ready to build your
xPC Target application.

Note If you do not tag signals before you generate your Simulink model,
you must specify model signals manually. See “Referencing Parameters and
Signals Without Using Tags” on page 3-41 for this procedure.

This procedure uses the model xpc_tank1.mdl (or xpctank.mdl) as an
example. See “Creating a Simulink® Target Model” on page 3-7.

Note The xpctank model contains tags from the example for creating custom
user interfaces in the xPC Target User’s Guide. As you follow the procedures
in this section and the section “Tagging Block Parameters” on page 3-8, you
should remove any existing tags before adding the new tags.

Notice that you cannot select signals on the output ports of any virtual blocks
such as Subsystem and Mux blocks. Also, you cannot select signals on any
function call signal output ports.

1 Open a Simulink model. For example, in the MATLAB window type
xpc_tank1 or xpctank.
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2 Point to a Simulink signal line, and then right-click.

3 From the menu, click Signal Properties. For example, right-click the
signal line from the TankLevel block.

Signal Properties. ..

Linearization Painks b

A Signal Properties dialog box opens.
4 Select the Documentation tab.

E: Signal Properties: {(unnamed) llil

Signal nanme; I

[T Signal name must resalve to Simulink signal objsct

Logging and accezzibility | Real-Time ‘Workshop | Docurnentation |

D escription:

#PCT a1 j=water_level;

Document Link,

ok Cancel Help Apply

5 In the Description box, enter a tag to the signals for this line.

For example, the TankLevel block is an integrator with a single signal that
indicates the level of water in the tank. Enter the tag shown.

6 Repeat step 5 for the remaining signals you want to tag.
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For example, for the signal from the ControlValve block, enter the tag
pump_valve.

E: Signal Properties: {(unnamed) llil

Signal nanme; I

[T Signal name must resalve to Simulink signal objsct

Logging and accezzibility | Real-Time ‘Workshop | Docurnentation |

D escription:

4PCT ag=pump_walve]

Document Link,

ok Cancel Help Apply

Signal tags have the following syntax:

xPCTag(1, . . . index_n)=label 1 . . . label n;

¢ index_n— Index of a signal within a vector signal line. Begin numbering
signals with an index of 1.

® label n— Name for a signal to connect to a property for the signal you
tag in the model. Separate the labels with a space, not a comma.

label 1...label_n must consist of the same identifiers as those used by
C/C++ to name functions, variables, and so forth. Do not use names like
-foo.

For single-dimension ports, the following syntax is also valid:

XPCTag=label;
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You can assign multiple labels to one tag, such as

xPCTag(1)=1abel;xPCTag(1)=1abel2;

You might want to assign multiple labels if you want to tag a signal
for different purposes. For example, you can tag a signal to create a
model-specific COM library. You might also want to tag a signal to enable
the function xpcsliface to generate a user interface template model.

You can also issue one tag definition per line, such as

xPCTag(1)=1abel;
xPCTag(2)=1label2;

To tag a signal line with four signals (port dimension of 4) use the following
syntax:

xPCTag(1,2,3,4)=1abel_1 label_2 label 3 label_4;

To tag the second and fourth signals in a signal line with at least four
signals, use the following syntax:

xPCTag(2,4)=1label_1 label 2;

7 From the File menu, click Save as. Enter a filename for your model. For
example, enter

xpc_tank1

Create the target application. See “Creating the Target Application and
Model-Specific COM Library” on page 3-14.

Creating the Target Application and Model-Specific
COM Library

Use this procedure to create a target application that you want to connect
to a GUI application and the model-specific COM interface library

(model_nameCOMiface.dll).

After you copy a Simulink model and tag the block parameters and block

signals, you can create a target application and download it to the target PC.



Example Visual Basic® GUI Using COM Obijects

This procedure uses the Simulink model xpc_tank1.mdl (or xpctank.mdl) as
an example (see “Creating a Simulink® Target Model” on page 3-7).

1 Start or reset the target PC with an xPC Target boot disk in the floppy drive.
Ensure that there is no other application currently loaded on the target PC.

2 If this is a new release of the product, ensure that you have configured the
host PC with the appropriate settings, including the compiler.

3 In the MATLAB window, type xpc_tank1 or xpctank.

A Simulink window opens with the model.md1 file.
4 From the Simulation menu, click Configuration Parameters.

The Configuration Parameters dialog is displayed for the model.
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#4, Configuration Parameters: xpc_tank1,/Configuration {Active)

Draka Yalidity

Twpe Conversion
Connectivity

b Campatibilicy
i~Model Referencing
Saving

-~Hardware Implementation
-Model Referencing

i Symbals
E----Custnm Code
t-Debug

Select: — Target selection =
- Solver
Syskem karget file: | xpctarget.tic
-~Daka ImporkfExpark ! S I petarg .
- ptimization Language: IC ;I
EI--Di;ngnu:ustics Description: *PC Target
i-5Sample Time

—Build process

TLiZ aptians: I

Makefile configuration

v Generate makefils

Make command: Imakﬁ_rtw

Template makefile: prc_default_tmf

[~ Generate code only

J K, I

5 In the left pane, click the Real-Time Workshop node.

Cancel | Help |

6 In the Target selection section, click the Browse button at the RTW

system target file list. Click xpctarget.tlc if it is not already selected,
then click OK.

7 In the left pane, click the xPC Target options node.

The xPC Target options pane is displayed.
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8 Select the Build COM objects from tagged signals/parameters check

box.
#fh, Configuration Parameters: xpc_tank1 /Configuration (Active)
Seleck: | — Target options =
----Dﬂa:aE;mpnrt,l'ExpDrt ¥ automatically download application after building
- Optimization IV Download ko defaul target PC
5~ Diagniostics Mame of xPC Target objeck created by build process | kg
-~ Sample Time
—Data Yalidity ¥ Use default communication timeout
il u:ul.'ﬁ:'ersu:-n —Execution options
-i_onneckivity
- Compatibility Execution mode IReaI-Time
~Model Referencing
= Saving Real-time interrupt source ITimer
~Hardware Implementation ) )
...Model Referencing I/ board generating the inkerrupt Ir'-.ll:une,l'other
E--R?aI-Time Warkshap PCI slak {-1: autosearch) or 154 base address I -1
—Data logging opkions
¥ Log Task Execution Time
Signal logging data buffer size in doubles | 100000
—Miscellaneous options
[T Double buffer parameter changes
[v Build COM obiects from tagged signalsjparameters
[T Generate CAMape exkensions
[ Include model Hierarche: on the karget application T
-
1| | 3
J Ik Cancel | Help | apply |

9 Click the Solver node.
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The Solver pane is displayed.

10 Check that the Stop time is long enough for you to interact with the target
application.

11 Click OK to save and exit.

12 From the Tools menu, point to Real-Time Workshop, and then click
Build model.

Th e Real-Time Workshop®, xPC Target, and a third-party C compiler
create the target application xpc_tank1.d1lm and the COM object library
xpc_tanki1COMiface.d1ll. The target application is also downloaded to
the target PC.

13 If you want, you can close the MATLAB Command Window.

Note To create the target application and build associated COM objects from
the tagged signals and parameters, you must use the Visual C compiler. You
cannot use the Watcom compiler to build these COM objects.

Your next task is to create a Microsoft Visual Basic API application using
COM objects. This API application connects and controls the target
application. See “Creating a New Microsoft® Visual Basic® Project” on page
3-21. For more information about model-specific COM interface library, refer
to “Model-Specific COM Interface Library (model_nameCOMiface.dll)” on
page 3-18.

Model-Specific COM Interface Library

(model_nameCOMiface.dll)

The generated model-specific COM interface library is a DLL component
server library that enhances programming using the xPC Target COM API
library. A model-specific COM interface library is specific to the model from
which it is generated; do not reference a model-specific library for another
model. If you choose not to generate a model-specific COM interface library,
refer to “Referencing Parameters and Signals Without Using Tags” on page
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3-41 for a description of how to otherwise reference parameters and signals in
the xPC Target COM API application.

The mode-specific COM interface library allows users easy access to
preselected tagged signals and desired tagged parameters for use in
conjunction with the xPC Target COM API xPC Target and xPCScope
object signal monitoring and parameter member functions such as
xPCTarget.GetParam, xPCTarget.SetParam, and xPCTarget.GetSignal.

The xPC Target COM generated objects are of two types:

®* model_namebio

® model namept

where model_name is the name of the Simulink model. The model_namebio
type is for tagged block I/O signals and the model namept type is for tagged
parameters.

Model-Specific COM Signal Object Classes

Model-specific COM signal classes have two types of members in which you
are interested, the Init function and class properties. You will find these
members in the model_namebio class, where model_name is the name of
your model.

The Init function invokes the Init method once, passing it the Ref
property from the xPCProtocol class. This method initializes the object to
communicate with the appropriate target PC to access the signal identifiers
when accessing the object’s properties. Refer to the call in the Microsoft Visual
Basic code example in “Creating the Load Procedure” on page 3-33.

Each class has a list of properties (specified in the Tag syntax in the
Description field of the signal property). These properties return the
xPC Target signal identifiers or signal numbers of the tagged signals.
The generated property name is the name specified in the tagged signal
description using the following syntax:

xPCTag=Property name;
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For example, in the model xpc_tank1.mdl, there are two signal tags in the
Description field:

¢ The output from the integrator block labeled TankLevel is tagged
xPCTag=water_level.

® The output from the multiply block labeled ControlValve is tagged
xPCTag=pump_valve.

Model-Specific COM Parameter Object Classes

Model-specific COM signal classes have two types of members in which you
are interested, the Init function and class properties. You will find these
members in the model_namept class, where model_name is the name of your
model.

The Init function invokes the Init method once, passing it as input the
Ref property from the xPCProtocol class. This method initializes the object
to communicate with the appropriate target PC to access the parameter
identifiers when accessing the object’s properties. Refer to the call in the
Microsoft Visual Basic code example in “Creating the Load Procedure” on
page 3-33.

Each class has a list of properties (specified in the Tag syntax in the
Description field of the block property). These properties return the xPC
Target parameter identifiers of the tagged parameters. The generated
property name is the name specified in the tagged signal description using
the following syntax:

xPCTag(1)=Property name;

For example, in the model xpc_tank1.mdl, there are two parameter tags in
the Description field:

¢ The parameter for SetPoint blocks is tagged xPCTag=set_water_ level;

¢ The parameters for the Controller block are tagged
xPCTag(1,2,3,)=upper_water_level lower_water_level
pump_flowrate;
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Creating a New Microsoft® Visual Basic® Project

The following procedures describe how you can create a Microsoft Visual Basic
project to take advantage of the xPC Target COM API to create a custom
GUI for the xPC Target application. The procedures build on the xpctank
(xpc_tank1) model you saved earlier (see “Creating the Target Application
and Model-Specific COM Library” on page 3-14). The Microsoft Visual Basic
environment allows you to interact with your target application using a GUI
while the target application is running in real time on the target PC.

The procedures for the following topics apply to Microsoft® Visual Studio® 6.0.
To use Microsoft Visual Studio 7.1 or 8.0 instead, see “Creating a New Visual
Basic® Project Using Microsoft® Visual Studio® 7.1 or 8.0” on page 3-47.

1 Create a new project directory.

From the directory matlabroot\toolbox\rtw\targets\xpc\api, copy the
file xpcapi.dll (API library) to this new project directory. Alternatively,
you can copy the file xpcapi.dll into the Windows® system directory.

You do not need to copy xpcapiCOM.d11l (the COM API library) into the
current directory, but ensure that it is registered in your system (see
“Registering Dependent Dynamic Link Libraries” on page 3-47.)

2 From your MATLAB working directory, copy the files model name.dlm
(target application) and model nameCOMiface.dll (model-specific COM
library) to the new project directory.

3 While in this project directory, open Microsoft Visual Basic. From the File
menu, click New Project.

The New Project dialog box opens.

Note Be sure to open the Microsoft Visual Basic project from the project
directory itself, not from Microsoft Visual Basic.
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4 Select Standard EXE, and then click OK.

The Microsoft Visual Basic Integrated Development Environment opens
with a blank form.

w. Projectl - Form1 (Form) - |IZI|£|

(m] [u] 1 -

5 From the File menu, click Save Project As and enter a filename for the
form and the project. For example, for the form, enter

xpc_tank1_COM. frm

At the project prompt, enter

xpc_tanki1_COM. vbp

Referencing the xPC Target™ COM API and

Model-Specific COM Libraries

You need to reference the xPC Target COM API and model-specific COM
libraries so that Microsoft Visual Basic will use them in the current project.
Assuming that you created the Visual Basic® project as described in the
preceding procedure, reference the library as described in this procedure:
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1 From the Project menu, click References.
The References dialog box opens.
2 Select the COM tab.

3 Scroll down the Component Name list to the bottom. Select the xPC
Target API COM Type Library check box.

4 Click Select.

5 Click OK.

References - xpc_tank_COM.vbp

pd
Available References:
[]wwindows Media Player UI ﬂ Cancel |
[]'Windows Media Strearmer Plugin Type Library
['windows Script Host Object Model (ver 1,00
[Jwizard1s 1.0 Type Library Browse. .. |
[J'Wrmdmlog 1.0 Type Library
[]wMI ADSI Exkension Type Library ﬂ
[C1WMICht 1.0 Type Library
[J'WMSClientMetManager 1.0 Type Library Prioritsy
[ 1wPChj 1.0 Type Library Help |

[wupdinfo 1.0 Type Library + |
[Twenroll 1.0 Type Librar

=B Targek AFT COM Tvpe Library

| p_tanleOMiFal:e 1.0 Twpe Library
-
1| | 3

—%F‘C Target APL COM Twpe Library

Location:  Dehworklxpcinewtestynew_wb_testhxpeapiCom. dil

Language: Standard

The xPC Target COM API Type library (xpcapiCOM.d11) is now available
for use in your project.
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6 To add the model-specific COM library, click References again from the
Project menu.

The References dialog box opens.

7 Scroll to find your model name. Select the check box xpe_tank1COMiface
1.0 Type Library.

8 Click Select.

9 Click OK.

References - xpc_tank_COM™M.¥bp

x|
Available References:
[Twindows Media Playver Cix :l Cancel |
[]wwindows Media Playver UI
[]'Windews Media Strearmer Plugin Type Library
['windows Script Host Object Model (ver 1,00 Browse. ., |
[Jwizard1s 1.0 Type Library
[Iwmdmlog 1.0 Type Library ﬂ
[]wMI ADSI Exkension Type Library
[]swMICht 1.0 Type Library Priority
[TwMsClienthetManager 1.0 Type Library Help |

[ 1wPchj 1.0 Type Library ﬂ
[I'WUpdInfo 1.0 Type Library

[laxenrall 1.0 Tyvpe Librar
vpe FanklCOMiface 1.0 Tvpe Library

< |

—xpc_tanklCOMiface 1.0 Type Library

Location:  diyworklxpc_tankllxpec_tankl _xpc_rbwixpc_tankl COMiface.c
Language: Standard

The model-specific COM API Type Library (xpc_tank1COMiface.dll) is
now available for use in your project. Sections “Viewing Model-Specific
COM Signal Object Classes” on page 3-25 and “Viewing Model-Specific
COM Parameter Object Classes” on page 3-26 describe how to look at class
objects.
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Because the xPC Target COM API is an add-on to Visual Basic, it might
help to know a bit about Visual Basic before going much farther with using
the COM API. The section “Creating the Graphical Interface” on page 3-27
guides you through using Visual Basic to create a project for the xpctank
or (xpc_tank1) model.

Viewing Model-Specific COM Signal Object Classes

After you create a Visual Basic project and reference the xPC Target COM
API and model-specific COM libraries, you can use the Visual Basic Object
browser (click the View menu and select Object Browser) to look at the
objects for the xpctankbio or xpc_tankibio class:

1 From the View menu, select Object Browser.

A dialog box pops up with a drop-down list containing all the type library
information for a project.

2 Select the drop-down list for the project/library.

A list of the project libraries appears.

‘7 Object Browser -0l x|
<All Libraries> =] | Bl ]
<All Libraries= v
Project! ﬂlLl
rmuﬂ'e embers of '=globalss"
VB b Al -
VBA s :l
= vBRUN i App
EXPC TAHKACOMIFACELiD oSN o
{XPCAPICOMLib -
21 App =% fscH
2F ApplicationStadCons =S Asciwy
1 AsyncProperty = Afn
B AsyncProperty vB5 *||=® Beep hd
=pAll Libraries=
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3 Select model nameCOMIFACELib.
The classes in your model appear.
4 To view the objects of a class, select that class.

The objects in your class appear.

The xpctankbio (or xpc_tankibio) class contains the function Init and
the two properties

® water_level

® pump_valve

Viewing Model-Specific COM Parameter Object Classes

After you create a Visual Basic project and reference the xPC Target COM
API and model-specific COM libraries, you can use the Visual Basic Object
browser (click the View menu and select Object Browser) to look at the
objects for the xpctankpt or xpc_tankipt class:

1 From the View menu, select Object Browser.

A dialog box pops up with a drop-down list containing all the type library
information for a project.

2 Select the drop-down list for the project/library.
A list of the project libraries appears.

3 Select model_nameCOMIFACELib.
The classes in your model appear.

4 To view the objects of a class, select that class.

The objects in your class appear.

The xpctankpt (or xpc_tankipt) class contains the method Init and the
member properties
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® pump_switch

® upper_water_level
® lower_water_level
® pump_flowrate

® water_level

® drain_valve

Creating the Graphical Interface

Forms are the foundation for creating the interface of a Visual Basic
application. You can use forms to add windows and dialog boxes to your Visual
Basic application. You can also use them as containers for items that are not
a visible part of the application’s interface. For example, you might have a
form in your application that holds a timer object.

The first step in building a Visual Basic application is to create the forms that
are the basis for your application’s interface. Then you create the objects that
make up the interface on the forms. This section assumes that you have a
Visual Basic project (see “Creating a New Microsoft® Visual Basic® Project”
on page 3-21). For this first application, you will use four types of controls
from the toolbox:

¢ Button

® Timer
Label
Scrollbar

1 Open xpc_tank1_COM. vbp.

2 On the left, from the General tool panel, click and drag the Button icon
1 to the form to create a button.

3 Repeat for a second button.

4 If you want to view signal data on the host, return to the General tool

panel and click and drag the Timer icon 5 to the form to create a timer.
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5 If you want to view signal data on the host, add a Label control to the form.

Return to the General tool panel and click and drag the Label icon A to
the form to create a label.

6 If you want to be able to vary the parameter input to the target, return

to the General tool panel and click and drag the HScrollBar icon 4 H
to the form.

7 Next, name your new form objects. Right-click the first button and select
Properties. This brings up the Properties dialog box. In the Caption box,
enter Load. Repeat for the second button, but enter Start. Repeat for
the third button, but enter Stop. (If you are unsure about how to work
with properties, refer to the procedure “Setting Properties” on page 3-29.)
After you name your new form objects and set whatever other parameters
you want (for example, if you use a timer you must increase the Interval
parameter), you can write the code behind these objects using the Visual
Basic code editor window (refer to “Writing Code” on page 3-31).

If you added a scroll bar to your project, it should look similar to the figure

below.
s projecti - orma (Form) _io/x]
O [m] ) ]
s Form1 =10l x|
Load Start | Stop |
D..
iy b
P SEERSSEEEERSRESERRE .
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If you added a timer and label to your project, it should look similar to
the figure below.

Note If you add a timer, remember to increase the interval of the timer to a
value greater than the default value of 0. Right-click the timer and select
Properties. This brings up the Properties dialog box. In the Interval box,
enter a value greater than 0, for example, 100.

. Prijectl - Forml (Form)

Setting Properties

This procedure describes how to set properties for the Visual Basic objects you
created on your form. If you already know how to set properties for Visual
Basic objects, proceed to “Writing Code” on page 3-31.
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The Properties window in the following figure provides an easy way to
set properties for all objects on a form. To open the Properties window,
choose the Properties Window command from the View menu, click the
Properties Window button on the toolbar, or use the context menu for the
control.

Properties - Form1 E3
[Form1 Form ] Object box
Alphabetic ICategnrized I Sort tubs
tMamne) Form1 =
Appearance 1-30 Properties [t
AutoRedran False
EackiColor [] aHsoo0000F
BorderSkyvle 2 - Sizable
Zapkion Form1
lipControls True
ZontrolBox True b
Drrawiode 13 - Copy Pen
DirawSkyle 0 - Solid
Dirawifidth 1
Enabled True
Fill Calar B :Hooooooo;
Fill Skyle 1 - Transparent
Fonk M3 Sans Serif
FonkTransparent |True
ForeColor B =Hsoo00012
HasDnZ True
Height 3570 ;I

{Mame)
Returns the name used in code ko
idenkify an object,

The Properties window consists of the following elements:

® Object box — Displays the name of the object for which you can set
properties. Click the arrow to the right of the object box to display the
list of objects for the current form.
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e Sort tabs — Choose an alphabetic listing of properties or a hierarchical
view divided by logical categories, such as those dealing with appearance,
fonts, or position.

® Properties list — The left column displays all the properties for the selected
object. You can edit and view settings in the right column.

To set properties from the Properties window,

1 From the View menu, choose Properties, or click the Properties button
on the toolbar.

The Properties window displays the settings for the selected form or
control.

2 From the properties list, select the name of a property.
3 In the right column, type or select the new property setting.

Enumerated properties have a predefined list of settings. You can display
the list by clicking the down arrow at the right of the settings box, or you
can cycle through the list by double-clicking a list item.

You can also set object properties directly in the code by using the following
dot notation: Object.propertyname=value.

Writing Code

The code editor window is where you write Visual Basic code for your
application. Code consists of language statements, constants, and
declarations. Using the code editor window, you can quickly view and edit
any of the code in your application.

The code editor window has three panes. The top leftmost pane is the object
list box. It is a dropdown list that contains all the form controls in your
project, plus a general section for generic declarations. The top rightmost
pane contains a procedure list box. For the selected or active control in the
object list box, the procedure list box displays the available procedures, or
events. Visual Basic predefines the possible procedures. The third pane
contains the code for the Visual Basic application. See the following figure for
a sample code editor window.
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M Projectl - Formi (Code) _|_|- 0 ﬂ
I(General} j I(Declaratiuns) j
| B
I
== | LHJ

In the general declarations section, declare a reference to the xPC Target
COM objects that you are using to interface with the xPC Target objects. The
following are the objects you need to declare:

xPCProtocol — Reference the classes corresponding to the target PC
running the target application and initialize the xPC Target API dynamic
link library. At a minimum, you must declare this object.

xPCTarget — Reference the classes for interfacing with the target
application. At a minimum, you must declare this object.

xPCScope — If the API application requires signal data, reference the class
for interfacing with xPC Target scopes. You need to declare a scope if you
want to acquire data from scopes or display data on scopes.

model namept — This is the COM object for tunable model/application
parameters.

model namebio — This is the COM object for model/target application
signals.
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Creating the General Declarations

This procedure describes how to create the general object declarations for
the xpctank (or xpc_tank1) model:

1 Double-click the form or, from the View menu, select Code.
The code editor window box opens for the control.

2 Select the General object.

3 Select Declarations in the procedure list box.

A template for the declarations procedure is now displayed in the code
editor window.

4 Enter declarations for the xPC Target COM objects you are using.

Public protocol_obj As xPCProtocol
Public target_obj As xPCTarget
Public scope_obj As xPCScopes

5 Enter declarations for the model-specific COM objects you are using.

Public parameters_obj As xpc_tankipt
Public signals_obj As xpc_tankibio

Creating the Load Procedure

This procedure describes how to program a load target application procedure
for the form. You might or might not want to allow users to download target
applications to the target PC. However, if you do want to allow this action,
you need to provide a control on the GUI for the user to do so. “Creating
Event Procedures to Load Applications” on page 3-36 describes how to provide
such a control.

1 In the project window, double-click the Form object.
The code editor window opens.

2 In the procedure list box, select Load.
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3 Create and initialize the objects for the Load method in the form. Note that
the following code also checks that the initialization of the protocol obj
succeeds. If it does not succeed, an error message is returned and the
application will exit.

Private Sub Form_Load()
Set protocol_obj = New xPCProtocol
Set target_obj = New xPCTarget
Set scope_obj = New xPCScopes
Set parameters_obj = New xpc_tankipt
Set signals_obj = New xpc_tankibio
stat = protocol_obj.Init
If stat < 0 Then
MsgBox("Could not load api") 'We can no longer continue.
End
End If
stat = protocol_obj.RS232Connect (0, 0)
stat = target_obj.Init(protocol_obj)
stat = scope_obj.Init(protocol_obj)
stat = parameters_obj.Init(protocol_obj.Ref)
stat = signals_obj.Init(protocol_obj.Ref)
End Sub

You can add more code to the Load method. This is the minimum code
you should enter for this method.
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Your code editor window should look similar to the following.

M Project1 - Forml {Code)
IFurm j ILuad

Dim protocol _obj Ais =xPCProtocol

D?m target ob] As xPCTarget
Dim scope_ob] As xPC3copes

Dim parameters_ob] As xpc_tanklpt
Dim =ignals ob]j A= xpe tanklbio

Private Sub Form Load(]
Zet protocol obj = New xPCProtocol
Set target okhj = HNew xPCTarget
Set scope obj = New XPC3copes
Set parameters obj = New xpc tanklpt
Zet signals obj = MNew xpc tanklbio

stat = protocol obj.Init
stat = protocol obj.R3Z3ZConnect (0, 0)
stat = target obj.Init(protocol obj)

stat = scope_obj.Init (protocol obj)

stat = parameters obj.Init (protocol obj.Ref)

stat = signals obj.Init(protocol obj.Ref)
End Zub

Creating Event Procedures

Code in a Visual Basic application is divided into smaller blocks called
procedures. Event procedures, such as those you create here, contain code
that mainly calls the xPC Target API component methods. For example, when
a user clicks a button, that action starts the xPC Target application.

This code is also responsible for the feedback action (such as enabling a
timer control, disabling/enabling controls) when an event occurs. An event
procedure for a control combines the control’s name (specified in the Name
property), an underscore (_), and the event name. For example, if you want
a command button named Command]1 to invoke an event procedure when
it is clicked, call the procedure Command1_Click. The following procedures
illustrate how to create event procedures, using the xpctank (or xpc_tank1)
model as an example.
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Creating Event Procedures to Load Applications
This procedure describes how to program the command button Command1
to load an application to the target PC through a serial connection. Provide

a procedure like this to allow users to download target applications to the
target PC.

1 Double-click the form or, from the View menu, select Code.

2 From the object list box, select the name of an object in the active form.
(The active form is the form that currently has the focus.) For this example,
choose the command button Command]l.

3 In the procedure list box, select the name of an event for the selected object.

Here, the Click procedure is already selected because it is the default
procedure for a command button.

ME Projectl - Forml (Code) _ o] x|

IComnmmH ﬂ ICIick ﬂ

Private Sub Commandl Click () -
End 3ub
[T Y 4

4 To load the target application, enter the path to the target application. If
the target application is in the same folder as the API application, enter ".".
Enter the name of the target application without the extension.

stat = target_obj.LoadApp(".", "xpc_tankil")

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Command1_Click()
stat = target_obj.LoadApp(".", "xpc_tank1l")
End Sub
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Creating Event Procedures to Start and Stop Applications

This procedure describes how to program the command buttons Command2
and Command3 to start and stop an application on a target PC:

1 If you are not already in the code editor window, double-click the form or,
from the View menu, select Code.

2 From the object list box, select the name of an object in the active form.
(The active form is the form that currently has the focus.) For this example,
choose the command button Command?2.

3 In the procedure list box, select the name of an event for the selected object.
Here, select the Click procedure.

4 To start the target application, select the StartApp method for the
command button Command2 (this is the button you named Start).

stat = target_obj.StartApp

5 To stop the target application, select the StopApp method for the command
button Command3 (this is the button you named Stop). Be sure to select
the Click procedure in the procedure list box.

stat = target_obj.StopApp

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Command2_Click()
stat = target_obj.StartApp
End Sub

Private Sub Command3_Click()
stat = target_obj.StopApp
End Sub

Creating Event Procedures to Vary Input Values

You can provide controls to allow users to vary the parameters of their
applications. The Scroll procedure is one way of varying input. The following
code uses the Visual Basic HScrollBar object to vary the water_level
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parameter. It takes the value from the HScrollBar object and sends that
value to the target as a parameter change.

Note This section assumes that you have tagged block parameters and
created your own model-specific COM library. Refer to “Getting Parameter
IDs with the GetParamIdx Method” on page 3-41 for a description of how to
manually perform the equivalent of using tagged parameters.

1 If you are not already in the code editor window, double-click the form or,

from the View menu, select Code.

2 From the object list box, select the name of an object in the active form.

(The active form is the form that currently has the focus.) For this example,
select the HScroll1 object.

The cursor jumps to the HScroll1 object template of the code editor window.

In the procedure list box, select the name of an event for the selected object.
Here, select the Scroll procedure.

Declare the slideVal variable as a double. The slideVal variable will
contain the value of the scrollbar.

Dim slideVal(0) As Double

Assign to the slideVal variable the result of CDbl. The CDbl function
reads the value of an object property. In this example, the object HScroll1
has the property slidevVal(0). CDbl reads the value of HScrolli.Value
and returns that value to slideval.

slideVal(0) = CDbl(HScrolll.Value)

Set the value of water_level to the scroll bar value slideVal, which is
from HScrollBar. The COM object target obj has the method SetParam,
which has the syntax SetParam(parIdx, newparVal). The SetParam method
references parIdx from the model-specific COM object (type xpc_tankipt).
To set the value of water_level to the scroll bar value slideVal, select
SetParam and continue typing. A list of the parameters you tagged in
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the Simulink model then pops up, and you can select the parameter
water_level and continue typing.

The call to SetParam should look like the following:

stat = target_obj.SetParam(parameters_obj.water_level,
slideVal)

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub HScrolli1_Scroll()
Dim slideVal(0) As Double

slideVal(0) = CDbl(HScrolli.Value)

stat = target_obj.SetParam(parameters_obj.water_level,
slideVal)
End Sub

Creating Event Procedures to Display Signal Values at the Host
You can provide controls to view signal values at the host. To do this, use a
combination of the timer and label controls. The following code uses the Visual
Basic timer control to display the water_level signal on the label control.

Note This section assumes that you have tagged signals and created your
own model-specific COM library. Refer to “Getting Signal IDs with the
GetSignalldx Method” on page 3-43 for a description of how to manually
perform the equivalent of using tagged signals.

Before you start, check that the Timer1 Interval property is greater than 0.

1 From the object list box, select the Timer1 object.

2 Assign to the Label1.Caption object the value of the water_level signal.
The COM object target_obj has the method GetSignal(sigNum). Reference
the sigNum parameter by passing it signals_obj.water_level. The CStr
function converts the returned value to a string so that it can be displayed
on the Labell object.
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When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Timer1_Timer()

Labell1.Caption =
CStr(target_obj.GetSignal(signals_obj.water_level))
End Sub

Note Although you add both a timer and label object to the Visual Basic
application, only the label appears on the GUI itself when the Visual Basic
application is run. The timer is not visible.

Creating Unload and Termination Procedures

You should write Form Unload and Termination procedures to ensure that
users are able to stop and unload the application appropriately, and to close
the communication between the host PC and target PC.

Note Provide Form Unload and Termination procedures to ensure that the
communication channel between the host PC and target PC properly closes
between each run of the GUI application.

The Terminate procedure controls the behavior of the Visual Basic Run
menu End option. The Unload procedure controls the behavior of the Visual
Basic Close button.

1 From the object list box, select the Form object.
2 From the procedure list box, select Terminate.

3 You are going to close the connection with the target PC, so type
protocol obj and select the Close method for that object.

protocol_obj.Close

4 From the procedure list box, select Unload.
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5 Repeat step

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Form_Terminate()
protocol obj.Close

End Sub

Private Sub Form_Unload(Cancel As Integer)
protocol obj.Close

End Sub

Referencing Parameters and Signals Without Using
Tags

The sample code in “Creating Event Procedures to Vary Input Values” on page
3-37 and “Creating Event Procedures to Display Signal Values at the Host”
on page 3-39 illustrates how to reference parameters that you tagged before
building the Simulink model. This section describes how to reference these
same parameters and signals from the COM API application code if you did
not opt to tag signals and parameters.

Getting Parameter IDs with the GetParamldx Method

When working with parameters in the context of varying input values, you
use the SetParam and GetParamIdx methods. The SetParam method has
the syntax

SetParam(ByVal parIdx As Integer, ByRef newparVal As
System.Array) As Long

where parIdx is the identifier that corresponds to the parameter you want to
set. To obtain the parameter ID, parIdx, for SetParam, you need to call the
GetParamIdx method. This method has the syntax

GetParamIdx(ByVal blockName As String, ByVal paramName As
String) As Long

The following procedure describes how to obtain the appropriate GetParamIdx
block name and parameter name for the Visual Basic HScrollBar object. You

need to reference the block name and parameter from the model namept.m
file.
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1 Open a DOS window.
2 Change the directory to the directory that contains your prebuilt model.

3 Open the file model namept.m. For example, you can use the notepad
text editor.

notepad xpc_tankipt.m

The editor opens for that file. If you are not in the directory in which the
xpc_tank1pt.m file resides, be sure to type the full path for xpc_tankipt.m.

4 Search for and copy the string for the block of the parameter you want to
reference. For the xpc_tank1 example, search for the SetPoint block if you
want to reference the water level. For example,

SetPoint

5 Return to the code editor window for your project.

6 In the line that contains the call to GetParamIdx, enter the path for the
blockName variable.

7 Return to the editor window for model_namept.m.

8 Search for and copy the string for the name of the parameter you are
interested in. For example,

Value

If you do not know the name of the block parameter you are interested
in, refer to “Model and Block Parameters” of the Simulink Reference
documentation.

9 Return to the code editor window for your project.

10 In the line that contains the call to GetParamIdx, enter the path for the
paramName variable. For example,

stat = target_obj.SetParam(target_obj.GetParamIdx
("SetPoint", "Value"), slideVal)
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When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub HScrolli1_Scroll()
Dim slideVal(0) As Double

slideVal(0) = CDbl(HScrolli.Value)

stat =
target_obj.SetParam(target_obj.GetParamIdx
("SetPoint", "Value"), slideVal)

End Sub

Note, if you want to retrieve the full block path and parameter name of a
block, use the GetParamName method. The GetParamName method returns a
variant data type object with two elements. The first element contains the full
block path, the second element contains the parameter name. The following
example illustrates how to use the GetParamName method to get the block
path and parameter name:

Dim Pname As Variant
Pname=xpc_tank1.GetParamName (GetParamIdx (Idx)
BlockPathString=CStr(Pname(0))
ParameterNameString=CStr(Pname(1))

In this example,

e Idx is the index to a parameter.
® BlockPathString contains the full block path string.

® ParameterNameString contains the parameter name string.

Getting Signal IDs with the GetSignalldx Method

When working with signals in the context of displaying signal values, you
use the GetSignal and GetSignalldx methods. The GetSignal method has
the syntax

GetSignal(sigNum As Long) As Double

where sigNum is the identifier that corresponds to the signal you want to set.
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To obtain the signal ID sigNum for GetSignal, you call the GetSignallIdx
method. This method has the syntax

GetSignalIdx(sigName As String) As Long

The following procedure describes how to obtain the appropriate
GetSignallIdx block name for the Visual Basic timer object. You need to
reference the block name and signal from the model_namebio.m file.

1 Open a DOS window.
2 Change the directory to the directory that contains your prebuilt model.
3 Open the file model namebio.m. For example,

notepad xpc_tankibio.m

The editor opens for that file. If you are not in the directory in which
the xpc_tankibio.m file resides, be sure to type the full path for
xpc_tankibio.m.

4 Search for and copy the string for the block of the signal you want to
reference. For the xpc_tank1 example, search for the TankLevel block to
reference the tank level. For example,

TankLevel

5 Return to the code editor window for your project.

6 In the line that contains the call to GetSignallIdx, enter the path for the
SigName variable.

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Timeri1_Timer()
Labelt.Caption =
CStr(target_obj.GetSignal(target_obj.GetSignalIdx("TankLevel"

)))
End Sub
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Testing the Visual Basic® Application

While creating your Visual Basic application, you might want to see how the
application is progressing. Visual Basic allows you to run your application
while still in the Visual Basic project. From the Visual Basic task bar, you can

click the Run button » . Alternatively, you can follow the procedure:

1 If you have the MATLAB interface and a target object connected, close the
port. For example, at the MATLAB command line, type

tg.close

2 From within the project, go to the Run menu.

3 Select Start or Start with Full Compile. The Start option starts your
application immediately. The Start with Full Compile option starts the
application after compilation.

The form you are working on pops up. Test your application. Ensure that
only one version of the application is running at any given time. To stop the

application from within Visual Basic, you can click the End button B fom
the task bar. Alternatively, you can go to the Run menu and select End.

Note If your Visual Basic application opens a communication channel
between the host PC and the target PC for the target application, be sure to
close that open channel between test runs of the Visual Basic application. Not
doing so can cause subsequent runs of the Visual Basic application to fail.
“Creating Unload and Termination Procedures” on page 3-40 describes how
to write a procedure to disconnect from the target PC. If you want to return
control to the MATLAB interface, be sure to close the Visual Basic project first.

Building the Visual Basic® Application

After you finish designing, programming, and testing your Visual Basic
GUI application, build your application. You can later distribute the GUI
application to users, who can then use it to work with target applications.

1 From within the project, go to the File menu.
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2 Select Make project name_COM.exe, where project_name is the name of
the Visual Basic project you have been working on.

3 At the pop-up box, select the directory in which you want to save the
executable. Optionally, you can also rename the executable.

The compiler generates the project _name_COM.exe file in the specified
directory.

Deploying the API Application

This section assumes that you have built your xPC Target application and
your Visual Basic xPC Target COM GUI application. If you have not yet
done so, refer to “Creating the Target Application and Model-Specific COM
Library” on page 3-14 and “Building the Visual Basic® Application” on page
3-45, respectively.

When distributing the Visual Basic model application to users, provide the
following files:

® project_name_COM.exe, the executable for the Visual Basic application

* model_name.dlm

Provide model name.d1lm if you expect the user to download the target
application to the target PC. Ensure that you have enabled an application
load event on the Visual Basic interface (refer to “Creating the Load
Procedure” on page 3-33).

If you expect that the target application is already loaded on the target PC
when the user runs the Visual Basic GUI application, you might not want
him or her to be able to load the target application to the target PC.

* model nameCOMiface.dll, if you tag the signals and parameters in the
model

® xpcapiCOM.d1l, the xPC Target COM API dynamic link library
e xpcapi.dll, the xPC Target API dynamic link library

Have the user ensure that all the files are located in the same directory before
he or she executes the Visual Basic application.
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You must also ensure that the user knows how to register the
application-dependent dynamic link libraries (refer to “Registering Dependent
Dynamic Link Libraries” on page 3-47).

To run the application and download an xPC Target application, users need
to have project _name COM.exe and model name.dlm, if provided, in the
same directory.

Registering Dependent Dynamic Link Libraries
This procedure uses xpc_tank1 as an example.

1 Open a DOS window.
2 Change the directory to the directory containing the API application files.

3 From the directory in which xpcapiCOM.d11 resides, register the xPC
Target COM API DLL by typing

regsvr32 xpcapiCOM.d1ll
DOS displays the message

D11RegisterServer in xpcapiCOM.dll succeeded

Creating a New Visual Basic® Project Using Microsoft®
Visual Studio® 7.1 or 8.0

The procedures for the preceding topics apply to Microsoft Visual Studio

6.0 (“Creating a New Microsoft® Visual Basic® Project” on page 3-21). The
procedures to use Microsoft Visual Studio 7.1 (NET 2003) and 8.0 are similar,

with the following exceptions. Note that references toMicrosoft Visual Studio
7.1 or NET 2003 also apply to Microsoft Visual Studio 8.0.

® You can open a Microsoft Visual Studio 6.0 project under Microsoft Visual
Studio .NET 2003. Microsoft Visual Studio .NET 2003 automatically
converts the project.

¢ Ifyou first create a new Visual Basic project, select Windows Application
as the template.

¢ When referencing the xPC Target COM API and model-specific COM
libraries, do the following
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a From the Project menu, click Add Reference.

The Add Reference dialog box opens.
b Select the COM tab.

¢ Scroll down the Component Name list to the bottom and select the
xPC Target API COM Type Library item.

d Click Select.

xPC Target API COM Type Library appears in the Selected
Components pane.

e Click OK.

When creating a reference to the xPC Target interface objects, include the
COM library. The following illustrates example code on how to reference
these objects in Microsoft Visual Studio .NET 2003 and Microsoft Visual
Studio6.0:

Microsoft Visual Studio .NET 2003

Public protocol_obj As XPCAPICOMLib.xPCProtocol
Public target_obj As XPCAPICOMLib.xPCTarget
Public scope_obj As XPCAPICOMLib.xPCScopes

Microsoft Visual Studio 6.0

Public protocol_obj As xPCProtocol
Public target_obj As xPCTarget
Public scope_obj As xPCScopes

When creating an instance of the xPC Target interface objects, include
the COM library. The following illustrates example code on how to create
an instance of these objects in Microsoft Visual Studio .NET 2003 and
Microsoft Visual Studio 6.0:

Microsoft Visual Studio .NET 2003
protocol_obj = New XPCAPICOMLib.xPCProtocol

target_obj = New XPCAPICOMLib.xPCTarget
scope_obj = New XPCAPICOMLib.xPCScopes
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Microsoft Visual Studio 6.0:

Set protocol_obj = New xPCProtocol
Set target_obj = New xPCTarget
Set scope_obj = New xPCScopes

® Microsoft Visual Studio .NET 2003 builds applications into the bin
directory of your project area. You cannot choose another location to place
your executable

® When distributing the Visual Basic model application to users, provide the
following files in addition to those listed in “Deploying the API Application”
on page 3-46:

= Interop.model_nameACOMIFACELib.d1l1l
= Interop.XPCAPICOMLib.d1ll
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xPC Target™ COM API
Demos and Scripts

Microsoft® Visual Basic® 7.1 (NET
2003) Demo (p. 4-2)

Microsoft® Visual Basic® 6.0 Demo
(p. 4-5)

Tecl/Tk Scripts (p. 4-8)

The Microsoft® Visual Basic® .NET

2003 demo illustrates how to create
a generic custom GUI that connects
to a target PC with any downloaded
target application.

The Microsoft Visual Basic 6.0
sf_car_xpc demo illustrates how to
create a custom GUI that connects
to a target PC that has a specific
(sf_car_xpc) downloaded target
application.

The Tcl/Tk demos are scripts that
illustrate how to directly access
COM API functions through a
command-line interpreter like
Tecl/Tk.
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Microsoft® Visual Basic® 7.1 (.NET 2003) Demo

In this section...

“Introduction” on page 4-2
“Before Starting” on page 4-3
“Accessing the Demo Project Solution” on page 4-3

“Rebuilding the Demo Project Solution” on page 4-4

“Using the Demo Executable” on page 4-4

Introduction

To help you better understand and quickly begin to use COM API
functions to create custom GUI applications, the xPC Target™
environment provides a number of API demos and scripts in the
C:\matlabroot\toolbox\rtw\targets\xpc\api directory. This topic briefly
describes those demos and scripts.

The Microsoft® Visual Basic® .NET 2003 demo illustrates how to create
a custom GUI that connects to a target PC with a downloaded target
application. The solution file for this demo is located in

C:\matlabroot\toolbox\rtw\targets\xpc\api\VBNET\SigsAndParamsDemo

® bin — Contains the executable for the demo project and the xpcapi.dll file

® Demo.sln — Contains a solution file for the Demo project

The Demo. sln file contains all the Visual Basic® .NET 2003 files to run the
windows form application. This demo is a functional application that you can
use as a template to create your own custom GUIs.

The COM API example from “Example Visual Basic® GUI Using COM
Objects” on page 3-4 is a simple GUI that illustrates some basic concepts for
creating a GUI with the COM API. The Demo solution is a more advanced
example that illustrates how to create a GUI similar to the xPC Target
Explorer. The Demo solution is fully commented.
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This demo illustrates how you can use the COM API to create a GUI that

® Connects to the target PC via an RS-232 or TCP/IP connection
e Starts and stops the target application loaded on the target PC
® Retrieves and lists all the signals in the target application

® Displays the value of a selected signal

® Retrieves and lists all the parameters in the target application

® Change the values of the parameters

Before Starting
To use the Demo solution, you need

® A target PC running a current xPC Target kernel

¢ A host PC running the MATLAB® software interface, connected to the
target PC via RS-232 or TCP/IP

® A target application loaded on the target PC

The xPC Target product ships with an executable version of the demo. If you
want to rebuild the Demo solution, of if you want to write your own custom
GUIs like this one, you need Microsoft Visual Basic .NET 2003 installed on
the host PC.

Note The xPC Target software allows you to create applications, such as
GUIs, to interact with a target PC with COM API functions. Chapter 3, “xPC
Target™ COM API” describes this in detail. To deploy a GUI application to
other host PC systems that do not have your licensed copy of the xPC Target
product, you need the xPC Target Embedded Option™. If you do not have the
xPC Target Embedded Option and would like to deploy your GUI application,
contact your MathWorks™ representative.

Accessing the Demo Project Solution
To access the Demo solution,
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1 Copy the contents of the VBNET directory to a writable directory of your
choice.

2 Change directory to the one that contains your copy of the Demo solution.
3 Double-click demo.s1n.

The Microsoft® Development Environment for Visual Basic application
starts.

4 In the Solution Explorer pane, double-click Form1.vb to display the
Demo solution form.

The form is displayed. You can inspect the layout of the demo.
5 To inspect the form code, select the View menu Code option.

The Visual Basic code for the form is displayed.

Rebuilding the Demo Project Solution
To rebuild the Demo solution,

1 Double-click demo.sln.

The Microsoft Development Environment for Visual Basic application
starts.

2 Select the Build menu Build Solution option.

Using the Demo Executable
To use the Demo solution executable,

1 Change directory to the one that contains your copy of the Demo solution.
2 Change directory to the bin directory.
3 Double-click Demo1 . exe.

The GUI is displayed.
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Microsoft® Visual Basic® 6.0 Demo

In this section...

“Introduction” on page 4-5
“Before Starting” on page 4-6
“Accessing the sf_car_xpc Project” on page 4-6

“Rebuilding the sf car_xpc Project” on page 4-7

“Using the sf_car_xpc Executable” on page 4-7

Introduction

The Microsoft® Visual Basic® 6.0 sf_car_xpc demo illustrates how to create a
custom GUI that connects to a target PC. The files for this demo are located in

C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualBasicModels\sf_car_xpc

This application interfaces with the xPC Target™ application
sf_car_xpc.dlm, built from the Simulink® model sf_car_xpc.mdl. This
model simulates an automatic transmission control system composed of
modules that represent the engine, transmission, and vehicle, with an
additional logic block to control the transmission ratio. User inputs to the
model are in the form of throttle (%) and brake torque (ft-1b).

This demo illustrates how you can use the COM API to create a GUI that

® Connects to the target PC via an RS-232 or TCP/IP connection

® Loads the sf_car_xpc.dlm target application to the target PC

e Starts and starts the target application engine

¢ Edits the stop time of the target application

e Edits the sample time of the target application

* Displays the speed, RPM, and gear of the target application engine
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Note For detailed information on the project, see the readme. txt file located
in C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualBasic\Models\
sf_car_xpc.

Before Starting
To use the sf_car_xpc project, you need

¢ A target PC running a current xPC Target kernel

¢ A host PC running the MATLAB®interface, connected to the target PC
via RS-232 or TCP/IP

The xPC Target product ships with an executable version of the sf_car_xpc
project. If you want to rebuild the sf_car_xpc project, you need Microsoft
Visual Basic 6.0 Professional installed on the host PC. If you want to view
or edit the model, you need to have the Stateflow® product installed on the
host PC.

Note The xPC Target environment allows you to create applications, such as
GUIs, to interact with a target PC with COM API functions. Chapter 3, “xPC
Target™ COM API” describes this in detail. To deploy a GUI application to
other host PC systems that do not have your licensed copy of the xPC Target
product, you need the xPC Target Embedded Option™ license. If you do not
have the xPC Target Embedded Option license and would like to deploy your
GUI application, contact your MATLAB representative.

Accessing the sf_car_xpc Project
To access the sf_car_xpc project,

1 Copy the contents of the VisualBasic directory to a writable directory of
your choice.

2 Change directory to the one that contains your copy of the sf_car_xpc
project.
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3 Double-click the Visual Basic® project. For example, double-click
sf_car_xpc_COM. vbp.

The Microsoft Visual Basic application starts.
4 In the right Project pane, expand the Forms folder.
5 Double-click the form you want to look at.
The form is displayed. You can inspect the layout of it.
6 To inspect the form code, select the View menu Code option.

The Visual Basic code for the form is displayed.

Rebuilding the sf car_xpc Project

To rebuild the sf_car_xpc project,

1 Double-click the Visual Basic project. For example, double-click
sf_car_xpc_COM. vbp.

The Microsoft Visual Basic application starts.

2 Select the File menu Make sf_car_xpc.exe.

Using the sf car_xpc Executable
To use the sf_car_xpc project executable,

1 Change directory to the one that contains your copy of the sf_car_xpc
project.

2 Change directory to the bin directory.
3 Double-click sf_car_xpc.exe.

The GUI is displayed.
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Tcl/Tk Scripts

In this section...

“Introduction” on page 4-8

“Required Tcl/Tk Software” on page 4-9

“Using the Demo Scripts” on page 4-9

Introduction

The Tcl/Tk demos are scripts that illustrate how to directly access xPC
Target™ COM API functions through a command-line interpreter like Tcl/Tk.
With Tcl/Tk

® You can write simple command-line scripts that communicate with a target
PC and the target application downloaded on that target PC.

® You can write simple GUIs that you can use to interact with a target
application downloaded on a target PC.

The files for this scripts are located in

C:\matlabroot\toolbox\rtw\targets\xpclapiltcltk

e xpcapi.dll — The xPC Target API DLL file. This file must be in the
current (pwd) directory. Alternatively, you can copy the file xpcapi.dll
into the Windows® system directory.

® xpcbase.tcl — Contains utility procedures used by the other scripts in
the series

® xpclists.tcl — Generates a list of signals or parameters for the target
application currently loaded on the target PC

® xpcload.tcl — Loads the specified target application to the connected
target PC

® xpcoutputlog.tcl — Reads log data from the target PC and plots the
data on the host PC

® xpcstart.tcl — Starts the target application loaded on the target PC
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® xpcstop.tcl — Stops the target application loaded on the target PC

® xpctargetping.tcl — Tests the communication between the host and
target PCs

® xpctargetscope.tcl — Creates a simple GUI that enables you to add
and control a scope of type target

® xpctune.tcl — Creates a simple GUI slider that enables you to manipulate
a parameter value for the target PC application

Required Tcl/Tk Software

To use these Tcl/Tk scripts, or to write your own Tcl/Tk scripts, you need

e An installation of a Tecl/Tk distribution on the host PC.

® An add-on package to the Tcl/Tk interpreter so that the scripts can
access the COM API objects. The tcom package is recommended.
This package was used to create the demo scripts in the
C:\matlabroot\toolbox\rtw\targets\tcltk directory.

® The math::statistics package. This package is required for the
xpcoutputlog.tcl file.

Note There are Tcl/Tk distributions that include required and useful
packages for use with the xPC Target software. For example, the Tcl/Tk
distribution at http://www.activestate.com contains these packages.

Using the Demo Scripts

The top of each Tcl/Tk script file contains directions on how to use each Tcl/Tk
scripts. In general:

1 Copy the contents of the tcltk directory to a writable directory of your
choice.

2 Change directory to the one that contains your copy of the Tcl/Tk script files.
3 Start your Tcl/Tk interpreter.

4 Load the Tcl/Tk script with the source command. For example,


http://www.activestate.com

4 .rc Target™ COM API Demos and Scripts

source xpctargetping.tcl

5 Run the loaded script. For example,

xpctargetping 192.168.0.10 22222

The selected script executes. In this example, xpctargetping.tcl tests
the communication between the host and target PC and returns a success
or failure message.
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API Function and Method
Reference

C API Functions (p. 5-2) Program with C API functions
COM API Methods (p. 5-10) Program with COM API methods



5 AP| Function and Method Reference

C API Functions

Logging, Scope, and File System Data structures for data logging and

Structures (p. 5-2) scopes

Communications Functions (p. 5-3) Communicate between host and
target PCs

Target Application Functions (p. 5-3) Manipulate target applications

Data Logging Functions (p. 5-4) Log data

Scope Functions (p. 5-5) Manipulate scopes

File System Functions (p. 5-7) Manipulate file systems

Target Scope Functions (p. 5-8) Manipulate scopes of type target

Monitoring and Tuning Functions Monitor and tune parameters and

(p. 5-8) signals

Miscellaneous Functions (p. 5-9) Manipulate miscellaneous xPC

Target components

Logging, Scope, and File System Structures

dirStruct Type definition for file system
directory information structure

diskinfo Type definition for file system disk
information structure

lgmode Type definition for logging options
structure

scopedata Type definition for scope data
structure
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Communications Functions

xPCCloseConnection
xPCClosePort

xPCDeRegisterTarget
xPCGetLoadTimeOut
xPCOpenConnection
xPCOpenSerialPort

xPCOpenTcplpPort

xPCReboot
xPCRegisterTarget

xPCReOpenPort
xPCSetLoadTimeOut

xPCTargetPing

Close RS-232 or TCP/IP
communication connection

Close RS-232 or TCP/IP
communication connection

Delete target communication
properties from xPC Target™ API
library

Return timeout value for
communication between host
PC and target PC

Open connection to target PC

Open RS-232 connection to xPC
Target system

Open TCP/IP connection to xPC
Target system

Reboot target PC

Register target with xPC Target API
library

Reopen communication channel

Change initialization timeout value
between host PC and target PC

Ping target PC

Target Application Functions

xPCAverageTET
xPCGetAPIVersion

xPCGetAppName

Return average task execution time

Get version number of xPC Target
API

Return target application name
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xPCGetExecTime

xPCGetSampleTime

xPCGetStopTime
xPCGetTargetVersion
xPCIsAppRunning

xPCIsOverloaded
xPCLoadApp

xPCLoadParamSet
xPCMaximumTET

xPCMinimumTET

xPCSaveParamSet

xPCSetSampleTime

xPCSetStopTime
xPCStartApp
xPCStopApp
xPCUnloadApp

Data Logging Functions

xPCGetLogMode

xPCGetNumOutputs

Return target application execution
time

Return target application sample
time

Return stop time
Get xPC Target kernel version

Return target application running
status

Return target PC overload status

Load target application onto target
PC

Restore parameter values

Copy maximum task execution time
to array

Copy minimum task execution time
to array

Save parameter values of target
application

Change target application sample
time

Change target application stop time
Start target application

Stop target application

Unload target application

Return logging mode and increment
value for target application

Return number of outputs



C API Functions

xPCGetNumStates
xPCGetOutputLog
xPCGetStateLog
xPCGetTETLog
xPCGetTimeLog
xPCMaxLogSamples

xPCNumLogSamples
xPCNumLogWraps

xPCSetLogMode

Scope Functions

xPCAddScope
xPCGetScope
xPCGetScopes
xPCIsScFinished

xPCRemScope
xPCScAddSignal
xPCScGetData
xPCScGetDecimation

xPCScGetNumPrePostSamples

xPCScGetNumSamples

xPCScGetSignals

Return number of states
Copy output log data to array
Copy state log values to array
Copy TET log to array

Copy time log to array

Return maximum number of samples
that can be in log buffer

Return number of samples in log
buffer

Return number of times log buffer
wraps

Set logging mode and increment
value of scope

Create new scope
Get and copy scope data to structure
Get and copy list of scope numbers

Return data acquisition status for
scope

Remove scope

Add signal to scope

Copy scope data to array
Return decimation of scope

Get number of pre- or posttriggering
samples before triggering scope

Get number of samples in one data
acquisition cycle

Copy list of signals to array
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xPCScGetStartTime

xPCScGetState
xPCScGetTriggerLevel
xPCScGetTriggerMode
xPCScGetTriggerScope
xPCScGetTriggerScopeSample

xPCScGetTriggerSignal
xPCScGetTriggerSlope
xPCScGetType
xPCScRemSignal
xPCScSetDecimation
xPCScSetNumPrePostSamples

xPCScSetNumSamples

xPCScSetTriggerLevel
xPCScSetTriggerMode
xPCScSetTriggerScope
xPCScSetTriggerScopeSample

xPCScSetTriggerSignal
xPCScSetTriggerSlope
xPCScSoftwareTrigger
xPCScStart

xPCScStop
xPCSetScope

Get start time for last data
acquisition cycle

Get state of scope
Get trigger level for scope
Get trigger mode for scope
Get trigger scope

Get sample number for triggering
scope

Get trigger signal for scope
Get trigger slope for scope
Get type of scope

Remove signal from scope
Set decimation of scope

Set number of pre- or posttriggering
samples before triggering scope

Set number of samples in one data
acquisition cycle

Set trigger level for scope
Set trigger mode of scope
Select scope to trigger another scope

Set sample number for triggering
scope

Select signal to trigger scope

Set slope of signal that triggers scope
Set software trigger of scope

Start data acquisition for scope

Stop data acquisition for scope

Set properties of scope
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File System Functions

xPCFSCD

xPCFSCloseFile
xPCFSDir

xPCFSDirltems
xPCFSDirSize

xPCFSDirStructSize
xPCFSDiskInfo

xPCFSGetError

xPCFSGetFileSize
xPCFSGetPWD
xPCFSOpenFile
xPCFSReadFile
xPCFSRemoveFile
xPCFSRMDIR
xPCFSScGetFilename
xPCFSScGetWriteMode
xPCFSScGetWriteSize
xPCFSScSetFilename

xPCFSScSetWriteMode

Change current directory on target
PC to specified path

Close file on target PC

Get contents of specified directory on
target PC

Get contents of specified directory on
target PC

Return size of specified directory on
target PC

Get number of items in directory

Information about target PC file
system

Get text description for error number
on target PC file system

Return size of file on target PC
Get current directory of target PC
Open file on target PC

Read open file on target PC
Remove file from target PC
Remove directory from target PC
Get name of file for scope

Get write mode of file for scope
Get block write size of data chunks

Specify name for file to contain
signal data

Specify when file allocation table
entry is updated
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5-8

xPCFSScSetWriteSize

xPCFSWriteFile

Target Scope Functions

xPCTgScGetGrid

xPCTgScGetMode
xPCTgScGetViewMode
xPCTgScGetYLimits
xPCTgScSetGrid
xPCTgScSetMode
xPCTgScSetViewMode
xPCTgScSetYLimits

Specify that memory buffer collect
data in multiples of write size

Write to file on target PC

Get status of grid line for particular
scope

Get scope mode for displaying signals
Get view mode for target PC display
Copy y-axis limits for scope to array

Set grid mode for scope

Set display mode for scope

Set view mode for scope

Set y-axis limits for scope

Monitoring and Tuning Functions

xPCGetNumParams

xPCGetNumSignals
xPCGetParam

xPCGetParamDims

xPCGetParamlIdx
xPCGetParamName
xPCGetSigldxfromLabel
xPCGetSigLabelWidth
xPCGetSignal

Return number of tunable
parameters

Return number of signals

Get parameter value and copy it to
array

Get row and column dimensions of
parameter

Return parameter index

Get name of parameter

Return array of signal indices
Return number of elements in signal

Return value of signal
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xPCGetSignalldx
xPCGetSignalName

xPCGetSignals
xPCGetSignalWidth
xPCSetParam

Miscellaneous Functions

xPCErrorMsg

xPCFreeAPI
xPCGetEcho

xPCGetLastError
xPCInitAPI
xPCSetEcho
xPCSetLastError

Return index for signal

Copy name of signal to character
array

Return vector of signal values
Return width of signal

Change value of parameter

Return text description for error
message

Unload xPC Target DLL

Return display mode for target
message window

Return constant of last error
Initialize xPC Target DLL
Turn message display on or off

Set last error to specific string
constant
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COM API Methods

Communication Objects
(xPCProtocol) (p. 5-10)

Scope Objects (xPCScopes) (p. 5-11)
Target Objects (xPCTarget) (p. 5-13)

File System Objects (xPCFileSystem)
(p. 5-15)

Work with COM API communication
objects

Work with COM API scope objects
Work with COM API Target objects

Work with COM API file system
objects

Communication Objects (xPCProtocol)

xPCProtocol.Close

xPCProtocol.GetLoadTimeOut

xPCProtocol.GetxPCErrorMsg
xPCProtocol.Init
xPCProtocol.isxPCError
xPCProtocol.Port

xPCProtocol.Reboot
xPCProtocol.RS232Connect
xPCProtocol.SetLoadTimeOut
xPCProtocol.TargetPing
xPCProtocol. TcpIpConnect

xPCProtocol.Term

Close RS-232 or TCP/IP
communication connection

Return current timeout value for
target application initialization

Return error string
Initialize xPC Target™ API DLL
Return error status

Contain communication channel
index

Reboot target PC

Open RS-232 connection to target PC
Change initialization timeout value
Ping target PC

Open TCP/IP connection to target
PC

Unload xPC Target API DLL from
memory
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Scope Objects (xPCScopes)

xPCScopes.AddFileScope
xPCScopes.AddHostScope
xPCScopes.AddTargetScope
xPCScopes.GetScopes
xPCScopes.GetxPCError
xPCScopes.Init

xPCScopes.IsScopeFinished
xPCScopes.isxPCError
xPCScopes.RemScope
xPCScopes.ScopeAddSignal
xPCScopes.ScopeGetData
xPCScopes.ScopeGetDecimation

xPCScopes.ScopeGetNumPrePost-
Samples

xPCScopes.ScopeGetNumSamples

xPCScopes.ScopeGetSignals
xPCScopes.ScopeGetStartTime

xPCScopes.ScopeGetState
xPCScopes.ScopeGetTriggerLevel
xPCScopes.ScopeGetTriggerMode
xPCScopes.ScopeGetTriggerModeStr
xPCScopes.ScopeGetTriggerSample

xPCScopes.ScopeGetTriggerSignal

Create new scope of type file
Create new scope of